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Chapter 1 	General Information 

Before You Start Multimedia Audio Card is a general term used in this manual 
to refer to the Sound Blaster Pro Series. An example is Sound 
Blaster Pro MCV. This manual covers the software for Multi-
media Audio Card. To install the software, refer to Getting 
Started that comes with the package. 

For software bundled in this package, refer to their respective 
manual for installation instructions. 

   

Important This manual assumes a certain degree of computer knowledge 
and understanding of DOS. Refer to your DOS manual for 
instructions in making backup copies, making or changing 
directories and other DOS operations. 
It also assumes you have installed Multimedia Audio Card's 
software on drive C:. If you have installed the software on a 
different drive, you should assume that drive C: in the manual is 
the drive you have installed. 

Sound 
Environment 

Multimedia Audio Card software uses two environment strings, 
SOUND and BLASTER, to locate the drivers and to get the 
hardware configuration. DOS's SET command is used to set the 
environment setting. (For additional information on the SET 
command, refer to your DOS manual). Two statements, SET 
SOUND and SET BLASTER, are added into AUTOEXEC.BAT 
by the installation program to set these environment strings. 
These statements set up the environment string whenever you 
turn on your system. 
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Sound Environment The Sound environment string specifies the directory location of 
Multimedia Audio Card's ' s sound drivers and other software. 
Many software packages rely on this environment setting to 
locate the sound drivers and other Multimedia Audio Card's's 
files. 

The SOUND environment string normally contains C:\SBPRO 
which specifies the directory of the software. To set this environ-
ment, enter the following at the DOS prompt: 

SET SOUND=C:\SBPRO 

Note: There is no space before or after the = (equal) sign. 

Usually, you are not required to do this. The installation program 
adds this into AUTOEXEC.BAT so that this environment string 
is automatically set up when you turn on your system. 

BLASTER 	 The BLASTER environment string specifies base I/O address, 
Environment 	 interrupt and DMA channel settings for Multimedia Audio Card. 

Most of the latest software get these hardware settings from the 
BLASTER environment. This eliminate the need for you to 
specify the hardware setting every time you run a program. 

The BLASTER environment string contains information on the 
hardware configurations which include base I/O address, inter-
rupt, DMA channel and card type. 

Base I/O address, interrupt, DMA channel are selectable by 
jumpers. (Refer to Getting Started for the location of the jump-
ers.) Card type is a number representing the card you have. Refer 
to the README file for the actual card type number of your 
Multimedia Audio card. 

To set BLASTER environment, enter the following at DOS 
prompt: 

SET=A220 17 D1 T2 
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The above example sets the factory default for the original 
Multimedia Audio card. The parameters are as follows: 

A specifies the base I/O port. 
I specifies the interrupt line. 
D specifies the DMA channel. 
T specifies the Multimedia Audio card type. SET- 

ENV.EXE will show the card number for your sound 
card. 

Note: There is no space before or after the = (equal) sign. But 
there must be at least a space between two parameters. 

Usually, you are not required to do this. The installation program 
adds this into AUTOEXEC.BAT so that this environment string 
is automatically set up when you turn on your system. 

Changing Blaster 	Two statements to set up the SOUND and BLASTER environ- 
Setting 	 ments are added into the AUTOEXEC.BAT during software 

installation. 

The SOUND environment is fixed. You need to change the 
BLASTER environment when you change the hardware settings 
like I/O address, interrupt and DMA channel. 

SET-ENV.EXE is a program that helps to update the SET 
BLASTER environment string in AUTOEXEC.BAT with new 
hardware configuration. To execute the program: 

1. Change to \SBPRO directory by entering CD\SBPRO. 
2. Start SET-ENV by entering SET-ENV. 
3. Specify the hardware setting according to what you have 

selected. If there is any hardware conflict, the program 
will report an error. It means that one of the cards on the 
system is using the same hardware setting. You have to 
choose a different setting. 

4. Take note of the card type number shown with the 
parameter "T". 

5. Reboot the system once when the program has updated 
the AUTOEXEC.BAT. 
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Installing Sound 
Drivers 

Third Party 
Software 

Some of the earlier versions of software that support Multimedia 
Audio cards do not support the BLASTER environment string. 
To run these software, you need to install the drivers if you have 
changed the factory default hardware setting. 

Once you have changed the default hardware setting, you need 
to reinstall the drivers to reflect the change. These drivers are 
CT-VOICE.DRV, SBFMDRV.COM and ORGAN.DRV. 

To install SBFMDRV.COM: 
1. Change directory to \SBPRO by entering CD\SBPRO. 
2. Run INST-DRV program by entering INST-DRV. 
3. Specify the hardware setting according to what you have 

selected. If there is a hardware conflict, the program will 
report an error. It means that one of the cards on the 
system is using the same hardware setting. You have to 
choose a different setting. 

4. Hit [Enter] to install the driver with the new hardware 
setting. 

To install CT-VOICE.DRV and ORGAN.DRV: 
1. Change directory to \SBPRO by entering CD\SBPRO. 
2. Run INST-DRV program by entering INST-DRV. 
3. Specify the hardware setting according to what you have 

selected. If there is a hardware conflict, the program will 
report an error. It means that one of the cards on the 
system is using the same hardware setting. You have to 
choose a different setting. 

4. Hit [Enter] to install the driver with the new hardware 
setting. 

Third party software packages normally contain music and 
sound drivers. You have to select the sound or music card during 
the installation or follow the instructions found in the manual to 
specify the parameter of the card. 

For software that is already installed, in some cases, you may 
need to reinstall the software to select the correct sound card. 
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The sound or music card is usually one of the following: 

■ Multimedia Audio Card 
■ Ad Lib Music Card 

Refer to the software's manual on how to specify the hardware 
configuration of your card. Some software may automatically 
detect it. Others may need special parameter in the command line 
or may need to be installed with an installation program. 
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Chapter 2 The Talking Parrot 

This mischievous parrot likes to mimic speech. It talks back, sometimes 

with outrageous remarks and it even giggles when tickled. You can say 

anything you want, in any language. You can press any key or simply 
leave it alone and see what happens. 

Important This program requires an AT (286) computer to run properly. A micro-

phone plugged into the Multimedia Audio Card is also required. If the 

microphone has a switch, make sure it is turned ON. 

Getting Started 

 

To start the program: 

1. Change to the SBPRO directory. 

2. Type PARROT and press Enter. 

3. When the screen displays a graph indicating noise level, press 

Enter and type a number that is ten counts above the noise level 

displayed (140 to 230) and press Enter again. For example, if the 
graph displays 130, type 140 and press Enter. 

4. When the parrot finishes its opening remarks, speak directly into 

the microphone with sufficient volume so that the parrot can hear 

you. 

5. Press the Escape key to leave the program. 
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Customizing Your 
Parrot 

Making Parrot Voices 

For those who want more fun out of the Talking Parrot, you can customize 
it by creating your own pictures and voices. There are four PCX format 
pictures used to make up the parrot. You can use any paint or draw 
program that saves in the .PCX format to create your own version of the 

Talking Parrot. 

Give your drawings the same file names as those listed in the table and 

copy them to the \SBPRO\PARROT subdirectory. 

Parrot .PCX Picture Files 

EGANGA Description 

PARROT.EO 

PARROT.E1 

PARROT.E2 

PARROT.E3 

Parrot with mouth closed 

Parrot with mouth open 

Parrot with mouth wide open 

Parrot with eyes and mouth closed 

The prerecorded voices for the Talking Parrot are stored in the 

PARROTV.VCB file. This file contains all 21 voices. To create your own 

voices, use Voice Editor II to record the 21 voices and give them the same 
names shown in the table. Store these files in the \SBPRO\PARROT 

subdirectory. 

To create the .VCB file: 

1. From the \SBPRO\PARROT subdirectory type MAKEPV and 

press Enter. 

Make sure that: 

■ All files are recorded at 10,000Hz sampling rate 

■ The voice data is NOT packed 

■ Each voice data in each file does not exceed 64K 

■ The sum of the size of the 21 voices must NOT exceed the free 

memory after the Talking Parrot is loaded. To be on the safe side, 

keep the file size less than 250K. 

■ Before running MAKEPV, ensure you have created .VOC files 

PVOC-A to PVOC-U. 
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Talking Parrot 
Voice Files 

Note: The program, MAKEPV, used to create the PARROTV.VCB file, 

checks for the existence of the original PARROTV.VCB file and asks 

your permission to overwrite it. 

The following tables contain the 21 voice files that make up the 

PARROTV.VCB. 

Random Greeting Message Files 

File Name Description 

PVOC-A.VOC 

PVOC-B.VOC 

PVOC-C.VOC 

PV0C-D.VOC 

PVOC-E,VOC 

PV0C-F.VOC 

PVOC-G.VOC 

PV0C-H.VOC 

PV0C-I.VOC 

PVOC-J.VOC 

Hello there. 

Hi ! how are you ? 

Good day . 

Welcome to the show. 

I'm a talking parrot. 

Please talk to me. 

Nice to see you. 

Please say something. 

Have a nice day. 

Goodbye. 

The Parrot will say files PVOC-A, PVOC-E and PVOC-D 
at start up. When you quit the parrot says PVOC-J and 
PVOC-I. 

Random Reply Message Files 

File Name Description 

PVOC-K.VOC 

PV0C-1....VOC 

PVOC-M.VOC 

PVOC-N,VOC 

PV0C-O.VOC 

Oh ! You sound terrible . 

Yak ! You have bad breath. 

What are you saying? 

What are you saying? (angrily) 

Don't talk nonsense. 

The Parrot will randomly refuse to play back the recorded 
voice and will send out one of these messages instead. 
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Reaction Message to Keyboard Files 

File Name Description 

PVOC-P.VOC 

PVOC-Q.VOC 

PVOC-R.VOC 

PVOC-S.VOC 

PVOC-T.VOC 

PV0C-U.VOC 

Ouch! 

Ooo..h 

Don't touch me! 

Go away! 

Hee..hee..hee 

 Herr..herr..herr 

When the keyboard is pressed, the Parrot will randomly 
send out one of these messages. 
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Chapter 3 Voice Utilities 
These voice utilities are helpful in creating and changing recorded sound 

files for multimedia applications. The following programs are found in 

the \SBPRO\VEDIT2 subdirectory: 

■ VOC-HDR—Adds headers to raw voice files 

■ JOINTVOC—Joins or combines voice files 

■ VREC—Records voice to disk from the command line 

■ VPLAY—Plays digitized voice from disk 

■ VOC2WAV—Converts .VOC voice files to .WAV files. 

■ WAV2VOC—Converts .WAV to .VOC files. 

Parameter 
Formats 

We have also included two additional programs, which are found in the 

SBPRO directory, for controlling and selecting input sources and volumes 

level. They are: 

■ SBP-MIX—A memory resident program for setting Multimedia 

Audio Card volume levels, selecting sound sources and filters. 

■ SBP-SET—Controls the selection of sound sources, filters and 

volume levels from the DOS command line. 

Most of the programs in this section have optional parameters. To 

eliminate some of the confusion , refer to the following conventions and 
standards used for describing files and optional parameters: 

■ filename.voc—Refers to a voice file. These can also be shown 

as sourcefile.voc, targetfile.voc and file 1 .voc. The .VOC extension 

refers to a Creative Voice File Format. All voice files are shown 

in bold. 

■ Options—Refers to optional settings. These are usually listed 

inside the brackets—you do not type the brackets or colons when 
setting options unless specified. The lower case letters refer to 

variable settings for each option. The options are shown in bold 

italics. 
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Adding Voice File 
Header 

The program VOC-HDR adds the CT-VOICE header to a raw sound file 
recorded from other sources. With the header added, Voice Editor II and 

other programs using the CT-VOICE driver can play the sound file. 

>. Entry format: 

VOC-HDR sourcefile targetfile.voc 

  

Important It is necessary to put the . VOC extension on the target file. 

Joining Voice 
Files 

Optional Parameters 

Example 

With the JOINTVOC utility, you can combine two or more voice files 
into a new file. 

Entry format: 

JOINTVOC / Ttargetfile.voc filel.voc file2.voc [/Saa /Mbb 
/Rcc /RE] 

Note: The parameters [/Saa/Mbb/Rcc/RE] can be added to each voice 
file. Decimal values for aa, bb and cc cannot be greater than 32767. 

Parameter Description 

Saa Adds a silence period to a voice file in units of 0.1 
seconds. 

Mbb Adds a marker to the file. During playback of the voice, 
if the marker is encountered, it sends a 2-byte flag. An 
application program can then decide how to act when 
encountering these flags. 

Rcc Requests a block to be repeated. Enter -1 for CC to 
request non-stop repeating. 

RE Ends the repeat command. 

If you want to join three files, where file2.voc repeats five times and then 

pauses for two seconds after playing file2.voc, this is entered as: 

JOINTVOC / Ttargetfile.voc filel.voc /R5 file2.voc /RE /S20 
file3.voc 
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Recording Voice 
Files 

Optional Parameters 

With VREC, you can record a voice from the DOS command line. The 

voice is recorded directly to the diskette or hard disk using a double-

buffering technique. The length of the recorded voice file is limited only 

by available hard disk space. 

30.  Entry Format: 

VREC filename.voc [B: kk] [IAA [/F: hh] [/S: hh] [/M: mm] 

[IL:nn] [IT:ss] [IQ] [/x="command line"] 

Parameter Description 

filename Filename for storing recorded voice. The default 
extension is .VOC. The voice is stored in the 
Creative Voice File format. 

/B:kk Sets the buffer size used for recording. The pro-
gram uses two buffers during the recording proc-
ess. kk is the size of the buffer in 2K units. If the 
buffer is not specified, a default value of 16 is 
assumed for kk (32K bytes per buffer). You can 
enter a range from 1 to 32 for kk. 

/A:ii Selects the recording source. The default setting 
is MIC. ii must be MIC - Microphone, CD - CD or 
LINE - Line in. 

/F:hh Selects the recording filter. hh can be either LOW 
or HIGH. The default is LOW. The cut-off fre-
quency for LOW is 4 kHz. The cut-off frequency 
for HIGH is 8 kHz. 

/S:hh Sets the recording sampling rate (frequency). The 
range for hh in MONO mode is from 4000 Hz to 
44100 Hz. In the STEREO mode, the sampling 
rate is fixed at 22050 Hz. 

/M:mm Selects the recording mode. Enter MONO or 
STEREO for mm. Default is MONO. 

/L:nn Controls the LINE input volume. nn can be from 
0 to 15. The default is O. 

/T:ss Sets the recording time in one second units. The 
range for ss is from 1 to 65535, giving a maximum 
recording time of about 18.20 hours. (Note: 
Function will not work when /X switch is specified.) 

Continued on Next Page 
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Playing Voice 
Files 

Parameter Description 

/0 Specifies Quiet screen mode operation. When 
specified, except for error messages, all other 
messages are suppressed. 

/X="command Go to DOS to execute a DOS command or 
line" another program after the voice process is acti-

vated. command line specifies the DOS com-
mand or a program to be executed containing up 
to 16 parameters. 

Use the program, VPLAY, to play a voice file from the DOS command 
line. The voice file can be any size but must be a Creative Voice File 

Format. 

Entry format: 

VPLAY filename.voc [/B: kk] [/T:ss][V]a="commandlinel 

Parameter Description 

filename.voc This is the voice file to play. The default extension 
is .VOC. The voice file must be in the Creative 
Voice File format. 

/B:kk Sets the buffer size used for playback. The program 
uses two buffers during the playback process. kk 
is the size of the buffer in 2K units. If the buffer is 
not specified, a default value of 16 is assumed for 
kk (32K bytes per buffer). You can enter a range 
from 1 to 32 for kk. 

/T:ss Sets the playback time in one second units. The 
range for ss is from 1 to 65535. (Note: This function 
will not work when /X switch is specified.) 

/0 Specifies Quiet screen mode operation. When 
specified, except for error messages, all other 
messages are suppressed. 

/X="command Go to 	DOS to execute a DOS command or 
line" another program after the voice process is 

activated. command line specifies the DOS 
command or a program to be executed containing 
up to 16 parameters. 
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Converting 
.VOC to .WAV 
Files 

Optional Parameters 

The program VOC2WAV provides a method of converting Creative's 

.VOC files to Microsoft's .WAV files 

)a° Entry format for converting .VOC to .WAV format: 

VOC2WAV sourcefile targetfile [/C:mm][/R:ss][ZS:bb][IL:rr] 

Note: When entering program command line, do not type brackets or 

colons. 

Parameter Description 

/C:mm Sets file to mono or stereo. mm can be either 1 for mono 
or 2 for stereo. Default is 1. 

/R:ss Sets sampling rate for .WAV file. ss can be 11, 22 and 
44. Default is 11 Khz. 

/S:bb Converts silence block from .VOC file to .WAV file data 
block. bb is either OFF or ON. Default is OFF. 

/L:rr Replicates repeat rate for the count specified in the 
.VOC file repeat to the .WAV file. Negative repeat 
counts are ignored and only one .WAV data block for 
repeating is created. rr is either OFF or ON. Default is 
OFF. 

Example Entry 	VOC2WAV sample.voc 
Formats 	 Performs a default conversion: mono voice data, sampling 

rate 11 KHz, dosen't expand silence blocks or repeat blocks. 

VOC2WAV sample.voc newsamp.wav /C2 
Performs a stereo voice data conversion. 

VOC2WAV sample.voc repsamp.wav /C2 /LON 
Performs a conversion with repeat blocks expanded. If 

sample.voc has the following format: 

Repeat 2 

VOCdata 

EndRepeat 
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The output file (repsamp.wav) will have the following data: 

WAVdata 

WAVdata 

WAVdata 

Converting 
.WAV to .VOC 
Files 

Example Entry 
Formats 

The program WAV2VOC provides a method of converting 
Microsoft's .WAV files to Creative's .VOC files 

Entry format: 

WAV2VOC sourcefile [targetfile] 

Note: DOS wildcards (*,?) may be specified for source file. Using the 

wildcard, the targetfile will retain the same name as the source file but 

with the .VOC extension. 

WAV2VOC waysamp.wav 

Converts the file waysamp.wav to waysamp.voc 

WAV2VOC *.wav 

Converts all WAV files to VOC files with the same name. 

Note: Remember the following points about .VOC to .WAV conversion 

■ Microsoft's .WAV files only support 11, 22 and 44KHz sampling 

rates. All VOC files are converted based on these rates. 

■ Although the program takes care of the difference in sampling 

rates, we recommend that the original sampling rate match either 

11Khz, 22KHz or 44KHz. 

■ Microsoft's .WAV file format supports only one block of data 

and can be played at only one sampling rate. Therefore, the 

source .VOC files should only contain blocks with the same 
sampling rate only. 

■ Do not nest repeat loops in the .VOC file. 

■ Packed .VOC file data blocks are ignored. 
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SBP-Mixer 

Changing the Hot-Key 

The Sound Blaster Pro Mixer (SBP Mixer) lets you control the volume 

of the following: 

■ Master—The overall volume of each source 

■ Voice—Digitized sound 

■ FM Music—Synthesized music 

■ CD—CD-ROM drive 

■ Line-In—Audio line-in 

To install the program into memory: 

1. Type SBP-MIX and press Enter. 

2. To activate the installed SBP-MIX, press and hold the ALT key 

and then the 1 key. 

3. To remove the program from memory, type SBP-MIX /u. 

A hot key consists of a shift status key and a number key on the main 

keyboard. 

Entry format: 

SBP-MIX [/khotkey] 

The parameter /k specifies the new hot key. 

The shift status key can be any of the following: 

■ SHIFTL—Left shift key 

■ SHIFTR—Right shift key 

■ ALT—Alternate key 

■ CTRL—Control key 

The number key is 1 to 9 on the main keyboard. For example, to specify 

the control key and 9 as the new hot key, type SBP-MIX /kCTRL9. 

Voice Utilities 	-7 



Accessing the SBP- 	Once you have loaded SBP-MIX, the menu will pop up at the DOS 
MIXER Menu 	 prompt or from any program when the hot key is pressed. 

Important 

  

SBP-MIX does not work from programs that take over the keyboard 

interrupt. In case this happens, you need to make settings with SBP-SET 

before running these programs. 

   

After activating SBP-MIX from text-mode, you can select options using 

either the keyboard or a mouse from the following menu: 

■ Card reset 	■ FM volume 

■ Master volume 	■ FM channel 

■ VOC volume 	■ ADC channel 

■ LINE volume 	■ ADC input test on/off 

■ CD volume 	■ Stereo on/off 

■ MIC volume 	■ Exit 

To select options using the mouse, place the cursor on the desired 
selection and press the left mouse button. To select from the keyboard, use 
the Up and Down Arrow keys and press Enter. After selecting from the 
main menu, an option menu is displayed. Highlight and select the option 

using the mouse or keyboard. 

Graphic Mode A full set of control will not be displayed when activating SBP-MIX from 

the graphic mode. Instead, functions are displayed at the bottom line of 

the screen. The functions can be selected using the Up and Down Arrow 
keys and the mixer parameter can be set using the Left and Right Arrow 
keys. Since there are no left and right volume control, the main volume 

of the mixer can only be contolled in graphic mode. 

SBP-SET 
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SBP-SET allows you to select and mix sound from different sources, 

choose filters and control individual volume. You make selections and 

setting from the DOS command line. 

To run SBP-SET: 

1. Type SBP-SET [/options] and press Enter. 



SBP-SET Options 
Option Description 

/0 Specifies the quiet screen mode. When selected, 
all other messages are suppressed except for 
error messages. 

/R Returns all settings to original defaults. 

/X:nn Sets microphone volume. nn is a range from 0 to 
7. The default is 0. 

/ADCF:xx Selects the recording filter cut-off frequency. xx is 
LOW or HIGH. The default is LOW. 

/ADCS:xx Selects recording source. The default is MIC. xx 
can be either MIC—Microphone, CD—CD or 
LINE—Line-in 

/ANFI:ON/OFF Selects the recording filter. ON records using the 
filter. OFF records without the filter. Default is ON. 

/DNFI:ON/OFF Selects output filter option. ON sends voice output 
through the filter. OFF bypasses the filter. Default 
is ON. 

NOLUME:I,r Sets the left and right volume levels for M—Master 
volume, FM—FM volume, VOC—Voice volume 
and LINE—Line-in volume. 

from 0 to 15 for I (left) and r (right) volume. The 
for Master, FM and Voice is 9, for Line-in it is 0. 

left volume to 7 and right volume to 9 for Line-in is 

at any time using the above parameters, or you 
in your AUTOEXEC.BAT file to set a volume 

your sound system. 

the following line in your AUTOEXEC.BAT file to 
volume to level 12, Digitized voice to level 14, FM 
level 12 and Line-in volume to level 12 : SBP-SET 

/FM:12,12 /LINE:12,12 

Volume levels range 
default volume 

Example: Setting 
entered as: /LINE:7,9 

You can set volume 
can place a command 
level suitable to 

Example: Putting 
set the Master 
music volume to 
/M:12,12 NOC:14,14 

/CD:nn Sets CD volume. nn ranges from 0 to 15. The 
default level is O. There are no left and right volume 
control for the CD. 
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Chapter 4 Voice Editor II 

Running Voice 
Editor II 

Voice Editor II is a DOS-based application that allows you to record and 

edit voice files. With Voice Editor II, you can cut away unwanted or 
unnecessary sounds from a voice file without removing important 

information. 

To run Voice Editor II: 

1. Change to \SBPRO\VEDIT2 sub-directory. 

2. Type VEDIT2 [/B:nn] and press <Enter>. 

A window displaying information about the application appears. 

The command line parameter is as follows: 

Parameter Description 

/B:nn This optional parameter allows you to set 

the buffer size for playing from disk by 
entering a number for nn in 2k units. The 

default for nn is 16, making the buffer size 32 

Kbytes. You get a smoother sound if the 

Bbuffer size is bigger. 
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Using the 
Keyboard and 
Mouse 

You can use the keyboard or a mouse to perform various operations in 

Voice Editor II . As there are many ways of using the two devices, only 

the basic operation for selecting the menu commands will be specified. 

Other ways of using the keyboard and mouse to access the menu 

commands will be specified when required. 

To access the menu commands using the keyboard: 

1. Press <Alt> and the underlined letter of the desired menu on 

the menu bar. 

2. Press the underlined letter to select the desired command. 

Note: When selecting the commands on the menu, you can also use the 

arrow keys and <Enter> to confirm the selection. 

To access menu options using a mouse: 

1. Click once on the desired menu from the menu bar. 

2. Click again to select the desired menu command. 

The Voice Editor II There are seven menus on Voice Editor II. They are File, Record, Play, 

Menus 	 Pack, Edit, CDisc and Volume. 

The File Menu 	The descriptions of the commands on the File menu are: 

Command Description 

Load Loads a voice file into memory. 

Save Saves changes made to the voice file. 

Save As Saves changes made to the voice file with a 

new name. 

Write Saves only selected blocks to a voice file. 

Intro Displays the copyright screen. 

Exit Quits Voice Editor II. 

- 2 	Voice Editor II 



The Record Menu 	The descriptions of the commands on the Record menu are: 

Command Description 

Settings Sets the sampling rate and the location for 

storing the recording. 

To Memory Stores the recorded data in system memory. 

To Disk Stores the recorded data in disk. 

Scan Input Scans the recorded data and displays it on the 

Scan Input window. 

The Play Menu 

The Pack Menu 

The descriptions of the commands on the Play menu are: 

Command Description 

From Memory Plays a voice file from system memory. 

Selected Blocks Plays only selected blocks of a voice file. 

Disk Plays a voice file from disk. 

The descriptions of the commands on the Pack menu are: 

Command Description 

Memory Compresses voice files from memory. 

Disk Compresses voice files from disk. 
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The Edit Menu 	The descriptions of the commands on the Edit menu are: 

Command Description 

Insert Adds blocks of information to an existing 

voice file. 

Delete Deletes blocks of information from an existing 

voice file. 

Modify Modifies blocks of information from an 

existing voice file. 

Move Moves selected blocks of information to a 

different location. 

Copy Copies selected blocks and moves them to a 

different location. 

Combine Combines voice block having the same 

sampling rate. 

The CDisc Menu 	The description of the command on the CDisc menu is: 

Command 
	

Description 

CD Player 
	

Runs the CD Player. 

The Volume Menu The descriptions of the commands on the Volume menu are: 

Command Description 

Master Controls master volume. 

Voice Controls digitized sound. 

CDisc Controls CD-audio. 

Line In Controls audio line-in. 
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LOAD 

Path C:\SBPRO\VEDIT2 

Filename I *.VOC 

Exit 

A 

[-A-]  
[-B-]  
[-C-]  

BBCNEWS 

CONGA 

TRAIN 

lot 

Loading Voice 
	

To load a voice file: 

Files 	 1. Choose Load from the File menu. 

The Load dialog box similar to Figure 4-1 appears. 

.VOC extension 
automatically 
added to file name 

VE-06 
Cancels 
request 

Figure 4-1: The Load dialog box. 

2. Select a voice file. 

The Block Type Information window similar to Figure 4-2 

appears. 

Sampling Unpacked File Size 
Rate 	File 

Displays 

Cursor 	Block number 
Voice 	8000 Hz 	UPK 8275 

Silence 	0.383 Sec 

Voice 	8000 Hz 	UPK 3458 

Voice 	8000 Hz 	UPK 1938 

Silence 	0.292 Sec 

Terminator 
V  

of cursor 
I 3  	location 
Blk Bgn 

0 	Displays beginning 
and ending number 

Blk End 	of selected blocks. 

0 
  Starting and ending 

I 	block numbers can 
be entered here to 
select blocks 

Block 
type 

End of 
File 

VE-07 

Figure 4-2: The Block Type Information window. 

The window displays the information contained in a voice file. Changes 

are reflected on the window when you edit the voice file. 
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Understanding 
Blocks 

A voice file consists of several blocks. The blocks can be any of the 

following: 

Block Type Description 

Header Defines a voice file for Sound Blaster Pro 

card. 

Voice The sound you hear. It can be mono or stereo. 

Silence Adds, changes or removes silence from a data 

block. 

ASCII text ASCII text strings that provide titles or other 

information. 

Marker Sends out a two-byte flag so other applications 
can perform certain tasks when encounters 

this marker. 

Repeat Provides a method for a block to repeat. 

End Repeat Indicates end of repeat blocks. 

Terminator Indicates end of file. 

Selecting Blocks Before editing or playing a Voice block, it is necessary to know how to 

select a block. Block selection is made on the Block Type Information 

window using the keyboard or a mouse. You can select more than one 

block at a time. However, the blocks selected must be next to each other. 

To select more than one block using the mouse: 

1. Click and hold down the left mouse button on the desired block. 

2. Drag the mouse to the block you want to select. 

3. Release the left mouse button. 

The blocks selected will be enclosed in a double-rule box. 
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IO 
10 

11 
12 

Blk Bgn 
Blk End 

I Split 

Voice 21730Hz UPK 32764 

Voice 21730Hz UPK 32764 

Voice 21730Hz UPK 32764 

Voice 21730Hz UPK 32764 

Voice 21730Hz UPK 32764 

Voice 21730Hz UPK 32764 

Voice 21730Hz UPK 32764 

Voice 21730Hz UPK 32764 

Voice 21730Hz UPK 32764 

Voice 21730Hz UPK 32764 

Voice 21730Hz UPK 32764 

Voice 21730Hz UPK 32764 

File size too large. 
Select blocks to be edited. 

Total free memory : 256735 
Selected Block size : 

To select more than one block using the keyboard: 
1. Press <B>. 

This activates the Blk Bgn text box on the right of the Block Type 

Information window. 

2. Type the number of the starting block and press <Enter>. 

3. Press <E>. 

This activates the Blk End text box on the right of the Block Type 

Information window. 

4. Type the number of the ending block and press <Enter>. 

The current block is highlighted and the block selected will be 

enclosed in a double-rule box. 

To select blocks quickly using the keyboard: 

1. Press <Ctrl+B> at the current block to mark the beginning block. 

2. Move the highlighted block using the up or down arrow to the 

ending block. 

3. Press <Ctrl+E> to mark the ending block. 

Loading Large 
Files 

Note: Terminator block cannot be selected. 

Since recorded files can be as large as available disk space, some files 

may be too large to load into memory. To overcome this limitation, Voice 

Editor II provides a method that allows you edit a portion of the file at a 

taime When a large file is loaded, two windows similar to Figure 4-3 

appear. 

[ ...ODEMEA 	 BiTerfiE. 

Figure 4-3: The windows displayed when loading a large file. 
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O Microphone 
O Line-In 
0 CD Mixer 

• Lo Filter 
O Hi Filter 
O No Filter 

0 Stereo 

®8 KHz 
011 Khz 
0 22.05 KHz 
044.1 KHz 
0 User Defined 

8000 Hz 

®To Memory 
0 To Disk 

Selecting User 
Defined displays 
Set Sampling 
Rate dialog box 

Set Sampling Rate 

Max. Rec. time : 	42 Sec 
Sampling Rate : 	8000 Hz 

Ok 

 

 

Exit 

The features on both windows allow you to modify the file so that it can 

be loaded into memory. To modify the file, you must split the file and than 

edit the split block. 

To split a file too large for memory: 
1. Select the desired block from the Block Type Information window. 

2. Select the Split button from the Message window. 

To edit a block: 
1. Select the desired block from the Block Type Information window. 

2. Select the OK button from the Block Type Information window. 

The Block Type Information window appears listing the blocks 

selected. 

3. To edit the block, select the desired command on the Edit menu. 

Selecting 
Recording 
Settings 

To select the recording settings: 

1. Select Setting from the Record menu. 

The Setting dialog box similar to Figure 4-4 appears. 

Settings 

Max. Rec. time 	42 Sec 

Ok 
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Figure 4-4: The Setting dialog box. 
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2. Select the desired settings. 

■ Select 8 or 11 kHz for voice-quality sound sampling, 22.05 
kHz for AM-quality sampling rate, and 44.1 kHz for audio 

CD-quality sampling rate. 

■ Select Low Filter for sampling rate below 18 kHz, High Filter 

for sampling rate between 18 kHz and 36 kHz, and No Filter 

for sampling rate above 36 kHz. 

■ Select Stereo if the recording source supports stereo mode. 

3. Choose OK. 

Scanning Audio 
Input 

Creating a 
Recording 

Note: Generally, the higher the sampling rate, the better the recording 

quality. 

To ensure that there is audio input from the recording source, an option 

that allows you to scan the audio input is available. 

To scan the audio input: 

1. Select Scan Input from the Record menu. 

The Scan Input window displaying an active waveform appears. 

(If you are using a microphone, you need to speak into it before 

you can see the waveform.) 

2. Once you are satisfied with the input, press <Esc> or click the left 

mouse button to remove the Scan Input window. 

Once the appropriate settings have been made, a recording can be made. 
You can either record to memory or disk. When you are recording to 

memory, make sure the recording is not too large because you only have 

a certain amount of available system memory. 

To record to Memory: 
1. Select To Memory from the Record menu. 

The Voice dialog box appears. 

2. Select the Stop button to finish the recording. 

When the recording is completed, the Block Information Type window 

will display a new Block Type Information window 
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To record to Disk: 
1. Select To Disk from the Record menu. 

The Record to File dialog box appears. 

2. Type in the name of the file in the Filename text box. 

3. Choose OK. 

Note: If you select an existing filename, you will be asked if you want 

to overwrite the file. 

Playing a 
Recording 

You can play back your recordings from the disk, memory, or selected 

blocks. 

To play a recording from memory: 
1. Load a file from disk into memory. 

2. Select From Memory from the Play menu. 

The Voice dialog box appears. 

3. Select the Stop button to stop playing from memory. 

To play a recording from disk: 
1. Select From Disk from the Play menu. 

The Play File dialog box appears. 

2. Select the desired file. 

3. Choose OK. 

The Voice dialog box appears. 

4. Select the Stop button to stop playing from disk. 

To play a recording from selected blocks: 
1. Select any combination of blocks from the Block Type Information 

window. 

2. Select Selected Blocks from the Play menu. 

3. Select the Stop button to stop playing the selected blocks. 

4 -10 Voice Editor II 



Editing Voice 
Files 

You can edit a voice file in the Block Type Information window using the 
commands on the Edit menu. 

To insert a block: 
1. Select the desired block. 

2. Select Insert from the Edit menu. 

The Insert dialog box similar to Figure 4-5 appears. 

Insert 

Silence 

Marker 

ASCII 

I Repeat 

Exit 

•-•-••,•..• 	J. • 	•., •• •• 

VE-25 

Figure 4-5: The Insert dialog box. 

3. Select the desired block from the Insert dialog box. 

A dialog box appears. 

4. Choose OK. 

The block you inserted will be displayed on the Block Type 
Information window. 

To delete a block: 
1. Select the desired block on the Block Type Information window. 

2. Select Delete from the Edit menu. 

The Delete dialog box appears. 

3. Choose Yes to confirm or No to stop the deletion. 

If no blocks are selected, you will be asked whether you want to 
delete the current block. 
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Compressing 
Voice Blocks 

To move a block: 
1. Select the desired block. 

The block selected will be enclosed in a box. 

2. Select the location to move the block to. 

The new location will be indicated by a highlighted block. 

3. Select Move from the Edit menu. 

The block will be moved to the new location. 

To copy a block: 
1. Select the desired block. 

The block selected will be enclosed in a box. 

2. Select the location to copy the block to. 

The new location will be indicated by a highlighted block. 

3. Select Copy from the Edit menu. 

The selected block will be copied to the new location. 

To combine blocks: 
1. Select the desired blocks. 

2. Select Combine from the Edit menu. 

The selected blocks will be combined. 

Note: Only voice blocks can be combined. 

Voice Editor II allows a voice block to be compressed in ratios of 4:1, 3:1 

and 2:1. The 4:1 ratio reduces the size of the voice block by 75%, 3:1 by 

66% and 2:1 by 50%. A compressed voice block is reflected in the Block 

Type Information window with the label PK1, PK2 or PK3. 

To compress a Voice block: 

1. Select a Voice block from the Block Information Screen. 

2. Select Memory or Disk from the Pack menu. 

The Pack File dialog box appears. 

3. Select the desired compression ratio. 
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Selected 
Voice data 

Changing the 
Characteristics of 
Voice Blocks 

You can change the shape and characteristics of a voice block 
by using Modify from the Edit menu. When the modify option 
is selected, the Editing Voice Data window similar to 
Figure 4-6 appears. 

End of file 

flay Zoom Blk Bgn 

End 

.20 Cursor I 0.42 I Sec 

  

.32 	I 

    

Figure 4-6: The Editing Voice Data window. 

The window displays the Voice block as a waveform. Three 
menus available for selections are Option, Edit, and Effect. 
The descriptions of the menus are: 

Menu Description 

Option Specifies options for splitting 	waveforms, 

changing sampling rates, and returning to 

Voice Editor II window. 

Edit Specifies options for editing the waveform. 

They are Save, Cut, Paste, Fill, and Insert. 

Effect Specifies options for creating sound effects. 

They are Amplify, Echo, Fade Out, Fade In, 

Pan Left-Right, and Pan Right-Left. 

Note: Only an uncompressed voice block can be displayed as a waveform. 

A compressed voice file only allows you to modify the sampling rate. 

When modifying a stereo voice file, two waveforms are displayed. 

However, you cannot modify the right and left channels individually. 
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Selecting a Waveform You can select a portion of the waveform using the keyboard or the mouse. 
When a portion of the waveform is selected, it will be highlighted. 

To select a portion of the waveform using the mouse: 
1. Click on the waveform and hold down the left mouse button. 

2. Drag the mouse to the portion of the waveform desired. 

3. Release the left mouse button once the desired portion of the 

waveform is selected. 

The selected portion will be highlighted. 

To select a portion of the waveform using the keyboard: 
1. Press <Ctrl+B> once you have placed the cursor on the waveform. 

2. Press <Ctrl+E> once you have selected the desired portion of the 

waveform. 

The keys that can be used for moving the cursor are: 

Keys Description 

<Tab> Moves the cursor quickly to the right. 

<Shift+Tab> Moves the cursor quickly to the left. 
, 

< < > Moves the cursor slowly to the left. 

< > > Moves the cursor slowly to the right. 

If you know the time interval between the beginning and ending points, 

you can enter the time in the Blk Bgn and Blk End text boxes. 

Splitting a Waveform 	To split a Waveform: 

1. Select a splitting point on the waveform. 

2. Select Split Block from the Option menu. 

The portion of the waveform on the right disappears. The split 

waveform will be displayed in the Block Type Information 

window. To view the split waveform, return to the Voice Editor 

II window by selecting Exit from the Option menu. 
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Changing Waveform 	To change the sampling rate of a waveform: 
Sampling Rates 	 1. Select Edit Sampling Rate from the Option menu. 

The Edit Sampling Rate dialog box appears. 

2. 	Choose OK once the desired rate is selected. 

Saving a Waveform 

Cutting a Waveform 

Note: When you change the sampling rate of a selected portion of the 

waveform, the voice block will change. 

To save a portion of the waveform: 

1. Select the desired portion of the waveform. 

The portion selected will be highlighted. 

2. Select Save from the Edit menu. 

The Save Data dialog box appears. 

3. Enter the filename and the directory path accordingly. 

To cut a portion of the waveform: 

1. Select the desired portion 

The portion selected will be highlighted. 

2. Select Cut from the Edit menu. 

The portion cut is held in memory until it is pasted onto the 

waveform. 

Pasting a Waveform 	To paste the portion cut onto the waveform : 

1. Select the position where you want to paste the waveform. 

2. Select Paste from the Edit menu. 

The portion cut will be inserted into the position selected . 

Filling a Waveform 	This command allows you to replace a selected portion of the waveform 

With Silence 	with silence. To fill a portion of the waveform: 

1. Select the desired portion. 

2. Select Fill from the Edit menu. 

The Fill dialog box appears . Enter a value between 0 and 255. 

The default value is 128 (silence). 

3. Enter the desired value. 
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Inserting a Waveform 	This command allows you to insert silence into a selected portion of the 

With Silence 	waveform. To insert a portion of the waveform with silence: 

1. Select the desired portion. 

2. Select Insert from the Edit menu. 

The Insert dialog box appears. Enter a value ranging from 0 to 

255. The default value is 128. 

3. Enter the desired value. 

Creating Special 
	

Special effects can be created using the commands on the Effect menu. 

Effects 
	

The descriptions of the commands on the Effect menu are: 

Option Description 

Amplify Changes the volume level of the entire or a 
portion of the waveform. Displays dialog box 

prompting for the magnitude of the volume in 

percentage. The default value is 200%. 

Echo Adds echo effect to the waveform. Displays 

a dialog box prompting for the percentage of 

the echo effect and the delay time. 

Fade Out Fades the current selection from 100% 

amplitude to silence (0% amplitude). 

Fade In Fades the current selection from silence (0% 

amplitude) to 100% amplitude. 

Pan Left-Right Allows a selected portion of the waveform to 
move gradually from left to right speaker. 

(Works only with stereo waveform.) 

Pan Right-Left Allows a selected portion of the waveform to 

move gradually from right to left speaker. 

(Works only with stereo waveform.) 
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Running CD 
Player 

If you have a CD-ROM drive installed, you can control the CD-audio 

using Voice Editor II 

To control the CD-audio: 
1. Select CD Player from the CDisc menu. 

The Compact Disc Control Screen similar to Figure 4-7 appears. 

Compact Disc 

Track 
Time 

Halt •• 

Last 14 

Rew 44 

Reset •  

12 
00:06 

Start ►  

Next 01 

F Fwd 

Pause 

Quitting Voice 
Editor II 

Exit  

moommoomoommommom....2>2......a 
VE-23 

Figure 4-7: The Compact Disc Control Screen. 

To set the volume of the CD-audio: 
1. Select CDisc from the Volume menu. 

The CD Volume dialog box. 

2. Choose Ok 

To quit Voice Editor II: 

1. 	Select Exit from the File menu in Voice Editor II window. 
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Chapter 5 MMPIay 
MMPlay provides an impressive method of creating eye-catching graphics 

combined with superb sound. This is accomplished by integrating 

graphic animation from Autodesk' s Animator and sound from the 
Multimedia Audio Card. You can easily combine Multimedia Audio 

Card with Autodesk Animator to create unique synchronized animation 

and sound audio/video presentations on your PC. 

Starting MMPIay To start MMPlay: 

1. Type MMPLAY <script> and press Enter. 

2. To abort the presentation, press the Ctrl and End keys at the same 
time (Num Lock must be off). 

Note: <script> is the name of the script file used to control the presentation. 

Scripts are ASCII files created with a text editor. The presentation stops 

only at the end of a play sequence. 

A multimedia demo using Animator designed graphics and the Multimedia 

Audio Card is also included. To start demo: 

1. Change to the SBPRO\MMPLAY subdirectory. 

2. Type MMDEMO and press Enter 

Script Commands When creating a script file, you enter a command on each line. You can 

use any text editor to create the ASCII scripts. 

The following conventions are used to describe script commands: 

■ Commands are not case sensitive. However, commands must be 

preceded with the period. 

■ The parameter shown as <item> is mandatory and must be entered 

with the command. 

■ When <item> I <item> is shown, one of them must be specified. 

■ Parameters [Item] in brackets are optional. 

Note: When entering multiple items, such as commands and parameters, 

separate them with one or more space characters. [ ] and < > are used 

for clarity and are not typed as part of the command string. 
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Command Description 

.APLAY <fli> Lets you play back the FLI sequence an 
indefinite number of times or until the SYNC 
condition is met. (See .SYNC command.) The 
playback can be terminated any time by hitting 
any key. <fli> is the name of an animation file 
created with 	Autodesk's Animator. These 
files use a .FLI extension. 

.APLAY1 <fli> Plays an FLI sequence once. 

.DELAY <ttt> Sets a delay time from one command to the 
next command. <ttt> is measured in .01 
seconds. Example: 100 equals 1 second. 

.PAUSE Lets you pause until a key is hit. 

.PLAY <fff> Plays a .CMF FM music file. 

.PLAYMIDI <fff> 
[Basic] I [Extended] 
I [General dd] 

This plays a .MID file. There are 3 options: 
Basic, Extended and General. 	Default is 
Extended. dd is the channel ranging from 1- 
16. 	Default is 10. 

.REPEAT <nnn> Sets how many times the next command is to 
be repeated. 	Default is one if nnn is not 
specified. 

. END Ends the .REPEAT command. Place this 
command after the repeat command. 

.SCREEN 
<0> I <1> 

Controls the clearing of screen at end of a 
presentation. If the parameter is 1, the screen 
is cleared and restored to the original mode. 
If it is 0, the screen remains in the 320x200 
256-color mode. 

.SYNC 

<Vn> I <Fn> I <Mn> 

Specifies the termination condition for 
subsequent .APLAY commands. 
V is the voice using a .VOC file. 

F is FM music using a .CMF file. 
M is FM music using a .MID file. 

n is the marker value to match. 

Note: Each Multimedia Audio Card driver for voice and FM music 
supports the embedding of markers into voice and music files. As the 
drivers process the files, they report the value of the markers 
encountered in MMPLAY. This makes it possible to synchronize the 
ending of a looping FLI sequence with the preceding music or voice. 

To wait for the end of a song or voice, the value n must be set to 0. 

Continued on Next Page 
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File 
Extensions 

Drivers 

Only the last .SYNC command preceding the .APLAY command has 
an effect. 

.STOP 

<V> I <F> I <M> 

Stops the Voice or FM music output 
immediately. 
V is the voice using a .VOC file. 
F is the FM music using a .CMF file. 

M is the FM music using a .MID file 

.VOUT <fff> Plays the .VOC digitized Voice file. 

.WAIT 
<Vn> I <Fn> I <Mn> 

Holds the presentation until a condition is met. 
(See the .SYNC command for parameters 
explanations.) 

.EXECUTE 
<DOS command 
line> 

Lets you execute a specified DOS command 
from MMPLAY. Returns to MMPLAY when 
the command is completed. 

.REM A remark sentence that MMPlay will recognize, 
but not execute. 

If a file in the script does not have an extension, the following default 

extensions are assumed: 

■ .PLAY music file - .CMF 

■ .PLAYMIDI music file - .MID 

■ .VOUT voice file - .VOC 

■ .APLAY FLI file - .FLI 

■ .APLAY1 FLI file - .FLI 

MMPlay requires the following drivers: 

■ Voice and Volume control—The CT-VOICE.DRV and 

AUXDRV .DRV drivers must be present in the DRV subdirectory 

of the path specified by the Set Sound command or in the current 

directory. 

■ FM music—SBFMDRV.COM and SBMIDI.EXE drivers are 

loaded by the user. 
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Sound Blaster 
Pro Extension to 
MMPlay 

Note: Except for CT-VOICE.DRV and AUXDRV, you do not need to 

load other drivers unless your presentation calls for them. MMPlay 

always loads the CT-VOICE and AUXDRV.DRV drivers. 

MMPLAY has added the following new commands to support CD audio 

and Mixer volume control on the Sound Blaster Pro. 

Command Description 

.VOLUME <source> 
< Ill> <rrr> 

Sets the left and right volume of selected 
sound source. Sound source can be one of 
the following: 

Voice, Line, CD, Mic, Music or Master 

Volume levels for <//l> and <rrr> range from 
0 to 255. The default value is 200. 

.PLAYCD <ttt> [ sss 
[ddd]] 

Plays the CD audio disc with the track number, 
time offset from beginning of song, and dura- 
tion of play set in <ttt> [sss[ddd]]. 	For ex- 
ample, if you want to play the fifth song on the 
CD, then <ttt> equals 5. Audio playback can 
start from an offset in terms of seconds 
specified in [sss]. If this is not specified, play 
starts from the beginning of the track. 

The duration of the playback is specified in 
[ddd] in terms of seconds. If this is not speci-
fied, the CD will play till the end of the disk. 

For example: PLAYCD 5 10 30 

Starts the CD playing from the 10th second of 
the 5th song for 30 seconds. 

.STOPCD Stops the CD music. 
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<- Play the animation file Z2.FLI once 

<- Play voice file BREATH2.VOC 2 times 

160 	160 

Script and Batch 
	

This sample batch file MMDEMO.BAT starts MMPLAY and executes 

Files 
	 script file MMDEMO.ACT. The examples of both files are as follows: 

Sample batch file MMDEMO.BAT 

\SBPRO\SBFMDRV 

MMPLAY MMDEMO.ACT 

\SBPRO\SBFMDRV /u 

Sample script file MMDEMO.ACT 

.VOLUME 	MASTER 
	

240 	240 

.VOLUME 	VOICE 
	

96 	96 

.VOLUME 	MUSIC 
	

240 	240 

.VOLUME 	CD 
	

0 	0 

.VOLUME 	MIC 
	

0 
	

0 

.VOLUME 	LINE 
	

0 
	

0 

.PLAY 	FAIRY 

.DELAY 	300 

.APLAY1 	Z2 

.REPEAT 	2 

.VOUT 	BREATH2 

.END 

.APLAY1 	Z1 

.VOLUME 	VOICE 

.VOUT 	ELE 

.APLAY1 	DOT 

.VOLUME 	VOICE 
	

0 

.VOUT 	501 

<- Play musicfile FAIRY.CMF in Background 

<- Delay for 3 seconds 

240 vTh 
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Troubleshooting When MMPLAY encounters an error, it displays an error message with 

the line number and the command. If sound or music is not heard: 

■ Check that the relevant driver is loaded. 

■ Make sure drivers are installed with the correct I/O address and 

Interrupt number. Refer to the section on installing drivers. 

■ Make sure the BLASTER environment matches the correct I/O 
address and interrupt number. 

■ Remove other TSRs (memory resident programs) if you suspect 
interference from them. 
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Chapter 6 CD PLAYER 

Getting Started 

Using CD Player 

CD-ROM driver requires two software drivers. They are a hardware 
device driver and a software device driver. 

The hardware device driver, which is hardware dependent, usually 
comes together with the CD-ROM drive. Different hardware cards and 
drives need different drivers. This driver must be included in the 
CONFIG.SYS with a "DEVICE=" statement. Refer to your specific 
CD-ROM drive user manual for more details on installing the driver. 
Some of them may come with a setup program that sets up the driver for 
you. 

The software driver MSCDEX is needed for normal application soft-
ware to access the CD-ROM drive as another driver on your system. 
With this driver, you can access the CD-ROM drive just like other 
drives on the system But you can only read and not write on it. 
MSCDEX will assign a drive letter for the CD-ROM drive. Normally, 
it will be the letter D if you only have a hard disk and your system 
configuration is simple. 

CD Player gives you full control over an attached CD-ROM drive. 
Using CD Player requires the installation of the above two drivers. Once 
these two drivers are installed, you can run CD Player. 

To run CD Player: 

1. Change to the SBPRO directory, type CDPLYR and press 

Enter. This executes a batch file to start the program. 

2. Select the desired CD Player control button (see Button 

Descriptions). 

The control screen displays current track information, time current track 

has played, current operation and audio disc volume. 

Icon-type control buttons operate the CD-ROM drive. You can execute 

functions using either the keyboard or a mouse. From the keyboard, move 

between controls by using the Arrow keys and press the Enter key to start 
the operation. The control button is highlighted when selected. 
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Play 62:50 

CD-09 

Rewind Play 
Mode 

Fast 
Fwd. 

Previous 
Track Stop Pause 

Elasped 
Time 

Sound Blaster CD Player 

Track: 01:00:00 

-41 

Sound Blaster CD Player Control Screen 

Next 
Track 

Volume 
Control 

Button Descriptions 

- 2 CD Player 

Control Description 

Play Starts the CD player. If already started, this 
will restart current track. 

Stop Stops the CD player . 

Pause/Continue Pauses the CD player until selected again to 
continue playing. 

Next Track Moves the CD player to the next track. If the 
disc's last track is encountered, it moves to 
the first track . 

Previous 
Track 

Selects the previous track. If the first track is 
encountered, it plays the final track. 

Fast 
Forward 

Fast-forwards the player by a 16 second 
count. If the end of disc is encountered, the 
function is ignored. 

Rewind Rewinds the player by a 16 second count. 
Function is ignored if the beginning of the disc 
is reached. 

Volume The volume control is controlled by a vertical 
bar at the right hand side. To change volume, 
move the control with the Up or Down Arrow 
keys until you reach the desired volume. With 
the mouse, simply select the right or left 
button. Left increases volume, Right de-
creases volume. 
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Chapter 7 FM Intelligent Organ 

The FM Intelligent Organ transforms your computer into an organ of 

incredible power and you into an instant musician. With one finger—or 

all ten, if you can manage. Learn to play complex musical pieces on your 

computer keyboard—the software adds the accompaniment (bass, chord 
and rhythm) in real-time. 

The FM Organ includes a learn mode to help you master the keyboard—

without stopping to learn music theory. And, if you have a 

MIDI-compatible keyboard, using our MIDI interface, increases your 

music-making capabilities tenfold. 

Getting Started To load: 

1. Go to the \SBPRO\PRO-ORG directory. 

2. Type PRO-ORG and press Enter. 

F OCTAVE 

Fl-help F2-play F3-replay F4-non stop F5-default F6-load F7-sa-ve F8-more 
FM-01 

Figure 1— Main Menu 
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If you have no fear of computers or keyboards, set this manual aside, press 
F2 and begin playing with the keyboard. You can press the Fl and the 
Page Up and Down keys to display a brief help summary of key defini-
tions. 

After playing around fora while, you will have a feel for the keys and how 

they are used. Then, when you need additional information, come back to 
the manual. 

There is a song located in your \SBPRO\PRO-ORG directory called 
DEMO. Feel free to load it in for replay, non-stop replay with all kinds 

of effects; changing instruments, accompaniments, tempo, etc. Go on and 

have a good time—you can't damage anything by playing the organ, and 
the HELP menu is always there to guide you. 

To load a song: 

1. Press F6. 

2. Use the Page Up and Down Arrow keys to highlight and select 

a song from the list of songs displayed. 

3. Press F4 to play the song. 

Important After loading, if you press F2 to play the song, you will hear only the 

rhythm and arpeggio—NOT the melody. If you press F2, you will have to 

reload the song to play it with melody. 

Play Mode 

Keyboard 
Terminology 

Before you start pressing keys, you need to know which keys to play. 

Figure 2 gives you a good picture of the PC keyboard representation of the 

normal piano keys. 

All keys of keyboard instruments are arranged in groups of 12 keys (5 

black and 7 white keys). Each in this group is called an octave and the first 

white key of each Octave is a "DO", the second white key "RE", the third 

"MI" followed by "FA", "SO", "LA", "TI". 

7 - 2 FM Intelligent Organ 



u. 

to 

0 

The Middle C is the "DO" note located at the middle of a piano keyboard 
and in the case of the Intelligent Organ, it is. the "DO" note of the D 
Octave. This Organ program has a very large keyboard; the equivalent 
of a large organ keyboard. There are seven octaves available and, for 
convenience, we named them octaves A, B, C, D, E, F and G. 
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Figure 2 — Seven Octave Piano Keyboard on Your PC 

FM Intelligent Organ 7 - 3 



Getting to Know 	At the main menu, press the F2 function key to enter play mode. 

Your Keyboard 	Press the Right or Left Arrow keys to shift the green color bar above the 

organ keyboard. Notice that the position of the D octave is always 

indicated and that the length of the moving green bar always covers four 

octaves. These four octaves represent the four rows of keys on you PC 
keyboard, namely rows 1, Q, A, and Z, used for playing the organ. 

For example, if the D-Octave is at the left hand side of the green bar, it 
means that the row Z represents the D octave. On the other hand, if the 
D octave is shifted to the right side of the green bar, then row 1 represents 
the D octave. 

Have you pressed F2 yet? Go ahead, press F2 and start messing around 
with those "piano keys". 

Try playing any of these keys on your PC and you should hear the 
corresponding note. If you cannot hear any sound, please check the 

volume control on your sound card and refer to Appendix C: Quick 

Reference for Problems Solving. 

You can actually go on playing (or messing around) for hours. Before you 
show off your musical talent, however, let's get a bit more sophisticated 

so we can show you what this organ can do. 

For those of you who don't seem to be able to find something to play, you 
can try one of the old favourite tunes on page 8-5 and 8-6. You play by 

simply pressing the keys that correspond to the numbers on the notes. 

Example The first 7 notes are: 

© © © 	 © ©) 

You can use any of the four octaves, that is, any of the four rows to play. 

If you choose row 1, type: (1 1 5 5 6 6 5 ) 

If you choose row Q, type: (Q Q T T Y Y T) 

After you finish playing the song, let's try playing it differently. This time 
press the spacebar first and start playing when the number counting on 

the top-left corner is 1. You will hear beautiful background music added 

to what you are playing. Press Esc to when you want to quit the Play 
mode. 
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TWINKLE, TWINKLE, LITTLE STAR 
(filename : TWINKLE) 

KEY 1=C 
	

Rhythm = March 

	

1 	1 

	

r 	r 	 
Twin - kle 	win - kle 	lit - 	tie 	star. 	how 	I 	won - der 

 

2 	1 4 

r 	 

7 

 

r 	r 

  

     

what you are? 
	

Up 	a - bove the 	world so high, 

7 1 	1 

	

r 	 
like 	a 	dia - mond 	in 	the 	sky. 	Twin - kle 	twin - kle 

lit - 	tie 	star 
	

how 	I 	won - der 	what you 	are. 
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KEY 1=C Rhythm = March 

J 	 

1 3 4 

gomarch ing 	in, 

1 3 di 	5 

-411- 

0 h, when the 	saints 

1 3 4 5 	3 	1 	3 

in. go ing saints march - Oh, when the 

4 3 3 3 2 1 

in that 
	

num ber 

3 3 4 1 	2 	1 

go march - ing herthe saints 

J J JJ 	 

I want to 
421. 
be 

J 	 

WHEN THE SAINTS GO MARCHING IN 
(filename : SAINTS) 
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F OCTAVE 

Save, Load and 
Replay 

Since this is your first song on the Organ, we are sure you would like to 

save it to show your friends. 

Fl-help F2-play F3-replay F4-non stop F5-default F6-load F7-save F8-more 
FM-01 

Figure 3 — Main Menu 

Saving a File 

Loading a File 

To save a file, press function key F7, and at the prompt, enter the name 

fo the song. For example, let's call it MYSONG1. Once you have entered 

the file name, press Enter. The song is now saved to disk. 

The Intelligent Organ actually remembers the song you are playing by 

storing it temporarily in a reserved memory area in your computer call the 

buffer. The buffer is 64K and under normal conditions, the words "Buffer 

Status" in the bottom-right corner are blue. When the buffer is almost full, 

they begin flashing red and when the buffer is full, they become a steady 

red. 

Perhaps you would like to play the song again before you save it. Press 

F4 to play again. Press F7 to save the song or Esc to quit. 

Just to make sure that you have saved your song correctly, press F2 to go 

to the PLAY mode and then press the Esc key to return to the main 

menu—going directly to the PLAY mode wipes out the song stored in the 

buffer. 

Now press F6 to display a pop up window containing all the songs titles 

on your disk. Simply move the cursor to select your song and press Enter. 

This loads the song into memory. 
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Octave D 

!!! 
 
I !!! II !PI II iii  II !!! 

.atiitt‘t 	 
Key 	: C 	Fl Piano F5 : March Melody Vol : 5 
Tempo : 120 F2 : Organ 1 F6 : Rhumba Arpg. Vol : Rhumba 
Scale : Major F3 Violin F7 : Swing B-C-R Vol : Disco 
Arpeggio : 1 	F4 : Synth 1 F8 : Waltz 	BUFFER STATUS 

Non-Stop Replay To play your song, press F4. The song plays repeatedly until you press 
the Esc key. You may make changes to your song while in the non-stop 
mode, but the changes made are temporary and are not be saved in the 
buffer. 

If you're finished playing with your song, let's try loading the DEMO 
song. At the main menu press F6 and select DEMO from the song list and 
press Enter. Next, press F4 for non-stop play. Now we can modify the 

song such as changing instruments, rhythym, etc. Go on, the power is with 
you, turn the song upside down. Try loading other songs for a non-stop 
play. Have fun! 

To save changes, press F3 to replay. In this mode, the song replays once 
and to hear the song again, press F3 again. Changes made in the replay 
mode are stored in the buffer. However, to avoid modifying the DEMO 
song permanently, enter a different song title such as DEMO2 when 
asked for a filename before saving. 

Instruments and 
Accompaniment 

Press F2 to get to PLAY mode. Notice the menu in the PLAY mode? Try 
pressing function keys Fl to F4 and what do you notice? Some words in 
the main menu begin to change color. 

Go on, choose something and start to play your tune. You can change 

instruments any time you fancy — simply press any of the keys Fl to F4. 

Each function key actually supports five instruments giving a total of 20 

instruments. Pressing a function key lets you to switch between the five 
instruments. 

ESC-Exit Non Stop SPC-Start/Stop Auto-Bass-Chord [,I-Auto Arpeggio 

FM-05 

Figure 4 — Play Menu 
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Instrument and 
Accompaniment 
Table 

Function Keys 
Fl F2 F3 F4 

In
s
tru

m
e

n
ts

 

Piano 

Harp 

Elguitar 

Marimba 

Alien 

Trumpet 

Saxafone 

Trombone 

Mars 

Organl 

Flute 

Harmonica 

Clarinet 

Violin 

Oboe 

Sitar 

Jamican 

Bells 

Synthl 

Synbass 

Function Keys 
Fl 	 F2 	F3 	F4 

R
h

y
th

m
s

 

March 

Marchi 

March2 

March68 

Rhumba 

Sambal 

Bosonovl 

Tangol 

Swing 

Swingl 

Rock & Roll 

Discol 

Waltz 

Waltzl 

Waltz2 

Jwaltz 

Auto-Bass-Chord 	You have probably found that playing a simple tune is not so difficult after 

all, but most tunes are not simple. They normally come with some 

background sound called accompaniment. The accompaniment enriches 
the quality (in most cases) of the main melody by adding bass, chord and 
rhythms. 

Bored? For some action simply press the spacebar to turn the accom-
paniment on. To turn off the accompaniment, press the spacebar once 
more. 

The intelligence of the Intelligent Organ lies in the fact that it is capable 

of adding the correct accompaniments to what you play—in real-time! 

Certain accompaniment will suit some songs better than others and the 

Intelligent Organ gives you a choice of 16 different accompaniments. Try 

changing the accompaniment by pressing function keys F5 to F8. 

To sound right, most songs have a proper ending so they do not end 
abruptly. Try ending the auto accompaniment for various types of Auto-
Bass-Chord accompaniment by pressing the Enter key. 
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Arpeggio OFF 

Proper Ending 

ON+ 

Artificial Melody 

Now, with more power at your finger tips, you are ready to take on the 

"Twinkle, Twinkle, Little Star" again and mesmerize your audience with 

a vastly sophisticated version. Choose an instrument you like and select 

March for your Auto-Bass-Chord accompaniment. Don't forget to give 

your song a proper ending before saving. If you don't want to overwrite 

your original song, name this one MYSONG2. 

ON- 

Figure 5 — PC Keyboard 

Auto Arpeggio 

Artificial Melody 

Ready for more fun? In addition to the Auto-Bass-Chord accompani-

ment, the Intelligent Organ gives a further enhancement to your songs 

by providing an Auto Arpeggio—automatically adding a built-in har-

monious melody to accompany your main melody. You can select any 

one of the six arpeggios using the Right and Left Bracket [ keys. Now 

add more spice to MYSONG2 using Auto Arpeggio. That's a good way 

to find out which sounds better. Use the' key to stop the Auto-Arpeggio 

(Refer to Figure 5). 

Instead of the Auto-Arpeggio, you can also add a string of melodies to 

what you are playing. This artificial melody is provided by pressing one 

of the following four keys: 
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Increase 
Tempo 

Decrease 
Tempo FM-07 

• 

Tempo Control 

The best effect is achieved by pressing one of the artificial melody keys 

during the long notes of your song. For example, press 9 to get a trill on 
the last note played. 

The jumping numbers at the top-left hand corner of your PLAY menu are 

actually the beat count provided by the Intelligent Organ to assist you in 

getting your tempo correct. You can vary the tempo by pressing: 

■ Ins—Increase Speed 

■ Del—Decrease Speed 

If you are still struggling to get your song right, because you cannot keep 

up with the pace of the song, don't despair. Simply decrease the tempo 
until you can key in your song comfortably. Add Auto-Bass-Chord and 

Arpeggio and you will still get to your sophisticated piece somehow. You 

can then increase the tempo gradually as your skill gets better. (To cheat 

a little, play your song in a slow tempo and replay it its regular tempo.) 

Figure 6 — Tempo Increase/Decrease Keys 
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Volume Control 
	

Besides the manual volume control on the Multimedia Audio Card, the 

Intelligent Organ has three individually volume controls: Melody, Auto-

Bass-Chord and Auto Arpeggio. You can adjust them individually to get 

the best sound effect for your songs. 

Important Now, here is some serious advice. Spend some time to master one song. 

If you can master one, you can master them all. 

Melody 
	

Arpeggio   BCR 
Increase 
	

Increase 
	

Increase 

Melody 	 
Decrease 

Arpeggio 	BCR . 
Decrease 	Decrease 

FM-08 

Figure 7 — Volume Control 

Some Music 
Fundamentals 

Time Signatures 

Earlier we mentioned that it was possible to play the FM Intelligent Organ 

without stopping to learn music theory. While that is true, we would like 

to offer some music fundamentals to help you along. 

At the beginning of a musical score, there is always a Time Signature. The 

most common are: 

3 	4 
4 	and • 4 which denote 3 beats and 4 beats respectively. 

For songs with 3/4 time signature, you should use only the waltz-type 

rhythms found on F8. 
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Major/ Minor Scale 
	

Most songs can be categorized into two groups. 

Selection 	 • Major Scale Accompaniments (F9) 

• 	Minor Scale Accompaniments (F10) 

As a rule of thumb, major-scaled songs begin with a major chord or end 
with 1(DO)—the first note of its key. Minor-scaled songs begin with a 
minor chord (Eg. Am, Em, Dm,...) or end with 6 (LA) — the sixth note 
of its key. 

For songs to sound proper, for major-scaled songs, use Major Scale 
Accompaniment F9, and for minor-scaled songs, use Minor Scale Ac-
companiment F10. 

Generally speaking, use F9 major accompaniment unless the songs ends 
with 6 (LA) or begins with a minor chord; then choose F10 minor ac-
companiment. 

Transposing Not every song is written in C key (1=C) — i.e. C is the DO note. Some 

tunes sound better if they are played in a higher key, while others sound 

better in a lower key. Moving your DO, RE, MI, etc. to a higher or lower 
tone is called transposing. The Intelligent Organ has a very convenient 
one-touch way of transposing. 

To hear the effect of transposing, go to the main menu and press F6 to load 
a song. Next press F4 for non-stop play and while the song is being 
played, press the following keys. 

Transposes music 
one semitone up 

Transposes music 
one semitone down 

Press the Shift key plus 
this key to transpose a 	 
perfect fourth 

   

Press the Shift key plus 
this key to transpose a 
perfect fifth 
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Octave D Octave E 

iii iii I I I I 	I I I 
FM-09 

	

3 	5 6 7 

	

#1 #2 	#4 #5 #6 
Di 	Ri 	Fi 	Si 	Li 

M QWER T Y U 

.1 
Di 

#2 
Ri 

#4 
Fi 

H 

#5 
Si 

J 

#6 
Li 

C V B N 

2 3 4 5 6 7 1 2 3 4 5 6 7 

Changing Octaves 	There are seven octaves playable from the Multimedia Audio Card and 

four octaves directly accessible at any time from your PC keyboard. You 

can gain access to all seven by using the Right and Left Arrow keys on 

the numeric key pad to shift octaves. 

Black Keys 	 Besides the four octave keyboard, the Intelligent Organ also provides 

and the Small 	users with a small keyboard with directly accessible Black Keys. Those 

Keyboard 	 who would like to play the Black Keys, press the Tab key to toggle the 

small keyboard with only two octaves (See figure 8). 

The four rows become: 

■ Row 1—Black keys (Octave E) 

■ Row Q—White keys (Octave E) 

■ Row A—Black keys (Octave D) 

■ Row Z—White keys (Octave D) 

Do Re Me Fa So La Ti Do Re Me Fa So La Ti 

Figure 8 — Small Keyboard Layout 
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If the black keys are accidentals, which occur rarely in your songs, you 

can play the black keys on the big keyboard by holding Shift key down 

while playing. 

Default Settings 

More Functions 

The defaults for functions like instruments, rhythm styles, speed, title of 
songs, etc. can be set by pressing F5 from the main menu. When in the 

Default Setting mode, you can use the Up and Down Arrow key to select 

the function. Alternatively you can jump to that function by pressing the 

highlighted character. Next use the Right or Left Arrown to move through 

the various options available Stop at the option you want to change. 

To enter the title of the song you must press T. Title must not exceed 24 
characters. After having set all the defaults, press Enter to end. Press Esc 

if you wish to quit without saving changes. Press 0 to restore all values 

to factory settings. 

By setting the defaults: 

■ You can change instrument, accompaniment, etc. with one touch 

of a button. 

■ The default settings are saved with the songs. 

■ You can change defaults after playing or loading a song. 

Pressing F8 from the main menu displays the following functions: 

■ Fl - LEARN—Allows you to learn an organ song that is loaded 

in the memory buffer. 

■ F2 - PATH—Allows you to set the directory path for save and 

load. 

■ F3 - SHELL—Allows you to shell to DOS temporarily; for 

example, to perform a DIR command. Type EXIT at the DOS 

prompt to return to FM Intelligent Organ. 

■ F4 - QUIT—Quit the program. 

■ F5 - MIDI TOGGLE—Enters or exits MIDI mode. 
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Learn Mode You enter the Learn Mode by pressing F8 from the Main menu and then 

pressing F 1 . The Learn Mode is an easy way to learn to play any organ 

song without becoming bogged down in music theory. It shows you how 

the song's notes are entered on the PC keyboard. 

To learn a song: 

1. Press F6 to load a song that you want to learn. 

2. Now press F8 and Fl to enter the Learn Mode. 

3. Press Fl (demo) again to see a demonstration of how the keys ar 

typed. 

4. Press F2 (learn). This highlights in brown the upper half of the 

key. This is the warning signal for you to get ready to press this 

key. When the bar turn purple and drops to the bottom half of the 
key, this is the exact time you must press the key. If you do not 

press the key in time, the song will wait, until you press the correct 

key. 

By practising a song repeatedly, it won't be long before you can play 

without assistance. If you have never played a musical instrument before, 

try it now, it can be really exciting. 

Using the MIDI 
Mode 

The FM Intelligent Organ supports the MIDI interface of the Multimedia 

Audio Card. Using the MIDI interface, you can play the FM Intelligent 

Organ using a normal organ keyboard. You can play with one hand and 

have the Intelligent Organ add the accompaniments for you. 

To use the MIDI Mode 

1. You need to get an electronic organ keyboard or synthesizer that 

has a MIDI interface. Use MIDI Kit to connnect the MIDI 

instrument. 

2. Connect the MIDI Kit to the Joystick Connector on the Sound 

Blaster Pro card. 

3. Plug the MIDI cable from the MIDI-IN on the MIDI Kit to the 

MIDI-OUT on the MIDI keyboard. 

4. Switch on the MIDI keyboard and set it to MIDI mode (Refer to 

your MIDI instrument's manual for details). 
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5. Start up the FM Intelligent Organ. 

6. Press Function Key F8 (more) then F5 (midi-toggle). This 

activates the MIDI mode of the FM Intelligent Organ and enable 

it to receive MIDI codes from MIDI keyboards. You can still use 

the PC keyboard to play notes and change the ORGAN functions. 

7. When the MIDI mode window displays, select the key signature 

that your are going to play. This is necessary so the FM Intelligent 

Organ can add the correct accompaniments to your song. 

8. Use the Arrow keys to change to the desired key signature. If you 

are not sure, count the number of sharps or flats in the key 

signature of your music score. Match the number of sharps or 

flats with those on the windows. 

■ Up Arrow—Increases number of sharps or decreases 
number of flats 

■ Down Arrow—Decreases number of sharps or increases 

number of flats 

■ Left Arrow—Lowers one semitone 

■ Right Arrow—Raise one semitone 

9. When you've selected the desired key signature, press Enter to 
return to the main menu. The MIDI mode is now turned ON. 

10. Press F2 to play. You can now play on the MIDI keyboard as 

well. The use of the MIDI keyboard doesn't hamper the functions 

of the FM Intelligent Organ. You can still change instruments, 

rhythms, tempo, keys, etc. using the PC's keyboard. 

11. If your song changes key signature midway through the song, 

you must also let FM Intelligent Organ know. Use the transpose 
functions; Shift + or Shift - on the numeric keypad to match the 

key signature on the screen with that you are playing. 

12. When you save a song played on the MIDI keyboard, you may 

play back the song like any other FM Organ song played on the 

PC's keyboard. You can't hear the tunes from the MIDI keyboard 
since the MIDI-Out to the MIDI keyboard is not implemented. 
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13. The song you save is transposed to its natural key signature—

the key signature where the song can be played without any black 

keys. During play back, the FM Organ transposes it back to the 

original key signature. This has the advantage that your song 

could be easily learned by others using the Lean mode. 

14. To end the MIDI mode, press F8 and F5. 
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Help 
Path cAstopro‘midi 

MIDI File to Queue-. 

MIDI Files 

lazzamid 
minuet-I _mid 
reggaea mid 

Fa--1 
I-b-I 
1-c-1 
[AA 
Ie  

ballada mid 

Chapter 8 Windows 3.1 Utilities 

The utilities described in this chapter requires Microsoft Windows 3.1. 
To use these utilities, you need to•have Microsoft Windows 3.1 installed 
on your system. 

Multimedia 
Jukebox 

You must also have the necessary Windows 3.1 drivers for the version 
of Multimedia Audio Card you have. If you have the drivers, refer to 
Getting Started or your Windows 3.1 manual for the installation of these 
drivers. 

The descriptions below assume a certain degree of understanding on 
using Microsoft Windows 3.1. If you are new to it, you may like to refer 
to your Windows 3.1 manual. 

This program uses the same conventions as most Windows application. 
You can use the mouse or the keyboard to make selections. By double 
clicking the left mouse button, you can select the files or change the 
directories. When the desired function is highlighted, press the ENTER 

key to execute this operation. You can also use the ALT key and the 
underlined character to select the buttons. 
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The MIDI Files box (see diagram on JukeBox) displays all the files with 
the .MID extension. The MIDI files, which are placed in the Play Queue 
box, are played in the order they appear. You can skip or remove a file any 
time. 

BUTTON DESCRIPTION 

Q All Pressing this button places all MIDI files in 
the Play Queue. 

Queue This button is used to place a selected MIDI 
file in the Play Queue. Select (highlight) a file 
and then press the Queue button. MIDI files 
can be placed in the Play Queue in any order. 
You can place a file in the Play Queue by 
double clicking the file in the MIDI Files box. 

Remove This removes a file from the Play Queue. 
Select a file in the Play Queue and press the 
Remove button. If a file is not selected, the 
first file is removed. 

Clear Press this button to clear all files from the 
Play Queue box. 

Quit Quits the program. 

Play/Stop This button starts/stops the songs in the Play 
Queue. The name on the button changes to 
reflect the current mode. To play a song, a file 
must be in the Play Queue. When the song 
has stopped playing, the file will disappear 
from the Play Queue. 

Pause/ 
Continue 

Press this button to pause the Multimedia 
Jukebox at the current song. The button will 
change to say "continue." The Multimedia 
Jukebox will remain at the Pause button until 
the Continue button is depressed. 

Skip Skips to the next song in the Play Queue. 
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Sound Blaster Pro 
Mixer 

Volume Control 

The Sound Blaster Pro Mixer lets you control the left and right sound 
levels and test the sound input level. You can save the default settings for 
the volume by selecting the Save button. Once saved, these settings remain 
until new changes are saved. Any changes made while in Windows 
remain until you quit Windows. When opening Windows, the last 
changes saved will be set. 

You can use the mouse or keyboard to select options. When using the 
keyboard, use the TAB key to move through the options. Holding the SHIFT 

key and then pressing the TAB keys moves you backwards through the 
options. You can also select options by pressing the ALT key. Use the 
ARROW keys to move the volume control scroll bars and to select the sound 
source and filter. Use the SPACEBAR to execute the Save button. 

Note: The microphone setting is not saved since the sound driver is 
always ON. This feature prevents the possibility of sudden and loud 
feedback noises when windows is started if the microphone is plugged in 
and turned on. 

The mixer allows you to set the sound levels for different sources played 
through the Multimedia Audio Card. It is necessary to set the master 
volume and source sound to a level audible to you. Although there are 
right and left control, not all sound input is in stereo. The microphone, for 
example, is mono only. Depending on the source recording, Line-In, FM, 
Voice and CD can be either mono or stereo. 

The SB Pro Mixer has the following volume control: 

• MAS—The Master volume control. This controls all sound volumes 
played through the Multimedia Audio Card. 

■ FM—FM Music 

■ CD—CD-ROM Drive 

■ Mic—Microphone 

■ Lin—Line In 

• Voc—Voice 
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To set the volume level: 

1. 	Double click the Sound Blaster Pro Mixer icon. The following dialog 
box appears: 

2. Select the volume you want to change and move the scroll bar up/ 
down to increase/decrease the sound level. 

3. Select Lock L/R Vol if you want the right and left scroll bars to move 
together. 

4. Select the Save button if you want to save your settings. (Mike 
settings are not saved.) 

To test the sound input level: 

1. Select sound source. 

2. Select the Start Test button 

3. Change the volume level of sound source to see a graphic representation 
of the sound input. 

4. Select filter to see how sound is affected. 

Note: Selecting either the high or low frequency filter is a matter of 
individual taste. Play around with the filter selection to see what sounds 
better to you. 
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Chapter 9 Sound Blaster's SBSIM 

Getting Started The Sound Blaster Standard Programing Tool (SBSIM) is resident 

memory driver that uses a configuration file to load and unload the 

various Multimedia Audio Card drivers (CT-VOICE, CTVDSK or 

AUXDRV) into memory. SBSIM lets external programs share access to 

the drivers. The SBSIM consist of a basic set of commands that start 

sound output and is consistent for all three sound drivers. This provides 
a simple method of programming applications to utilize the Multimedia 

Audio SCSI card. 

SB SIM advantages: 

■ Relief from the drudgery of loading and unloading Sound Blaster 

sound drivers. 

■ Flexibility in choosing the driver to load for your application 

■ Easy programming method for playing CMF, MID and VOC 

files with a simple and consistent command set. 

■ Access to the same piece of music or voice from different DOS 

applications at the same time. 

■ Full use of extended memory to play VOC files, taking advantage 

of SBSIM's close coupling with the CT-VOICE driver. 

Those are just a few of the things that the SBSIM can do for you. This 

approach frees application programs from loading drivers and the asso-

ciated task of allocating memory for the drivers. SBSIM takes care of 

starting up, initializing and terminating the drivers along with loading 

music and voice files for the sound drivers. 

If the CT-VOICE driver is loaded and extended memory support indi-
cated, SB SIM can load voice files into extended memory, allocating and 

freeing enough memory for the file. It can also use extended memory 

blocks that have been allocated by other programs. This new, simple way 

of utilizing your Multimedia Audio Card frees the application programs 

from extended memory programming. 

Sound Blaster's SBSIM 0 -1 



;1=Basic MIDI files 
;2=Extended MIDI files 
;Note that types 1 and 2 
;are as defined in 
;Multimedia Windows. 

0 

Configuration Files The configuration file is a simple text-based file used by SBSIM. You 

create and edit these file using a word processor or text editor such as 

EDLIN. All files must be saved in ASCII format. 

Configuration files specify which drivers to load in memory plus the 

setup parameters for each driver. This lets you tailor the configuration file 

to suit your application's needs. 

SBSIM reads configuration files when it starts up and loads the drivers 

specified in the file. After starting up, configuration cannot be changed. 

To use a different configuration file, it is necessary to unload SB SIM first, 

then reload SBSIM with another configuration file. 

A configuration file consist of several sections. Each section specifies 

which Multimedia Audio Card driver is loaded. These drivers are 

indicated by a keyword identifying the driver. 

/Th 
; This is a sample SBSIM configuration file 

fa'‘g 

; Load FM driver 

[FM] 

BufferSize=16 ;Use buffer size of 16 kilobytes 

;Load the CT-Voice Driver 

0 	[MemVoice] 
ExtendedMemory=ON ;use extended memory 

SBSIMhandles=5 ;allocate only 5 handles 

(I) 	[MIDI} 

BufferSize=32 	 specifies the size of the buffer 

; to allocate for MIDI files in Kbytes. 

MidiMap=0 	 ;specifies the type of MIDI 

(I) 	
;file to be played: 

;0= General MIDI files 
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Driver and Keywords 
Table 

You can only load drivers identified by their keyword. You can add 
optional parameters—one per line for each driver (see sample configu-

ration file and section on setting parameters.) 

Since the FM driver SBFMDRV and the MIDI driver SBMIDI are 

resident drivers, they cannot be loaded by SBSIM. You must manually 

load these drivers prior to running SBSIM which checks that they have 

been loaded. 

Driver Keyword Description 

SBFMDRV [FM] FM driver 

CT-VOICE [MemVoice] Memory-mode voile drivers 
for conventional and extended 
memory 

CTVDSK [DskVoice] Disk double-buffering voice 
driver 

AUXDRV [Auxiliary] Auxiliary driver for Mixer 
control 

SBMIDI [Midi] Midi driver 

Setting Parameters 	There are two type of values for parameters: 

■ Numeric — These are decimal values. 

■ On/Off — Sometimes referred to as Boolean, these values use 

the words ON and OFF for true and false values. 

SBSIM uses a default value for the parameters if one isn't specified. You 

can also insert comments in the file by placing a semicolon in front of the 

comment. 
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Parameters and 
Settings 

Driver Keyword Option 

SBFMDRV.COM [FM] BufferSize= nn 

Buffer size default is 32K. If the buffer size is set to 0 (zero), SBSIM 
does not allocate a buffer for CMF files. The application must set aside 
its own buffer before starting CMF music. This prevents several 
applications from using the same piece of music. 

CTVDSK.DRV [DskVoice] BufferSize=nn 

Buffer size default is 32K. If the buffer size is set to 0 (zero), SBSIM does 
not allocate a buffer for VOC files. The application must set aside its 
own buffer before starting VOC output. This prevents several applications 
from using the same voice file. 

CT-VOICE.DRV [MemVoice] ExtendedMemory=aa 

Default is OFF. Setting aa to ON enables extended memory support 
for VOC files. An application program can load a VOC file into extended 
memory and later play the file through SBSIM or CT-VOICE. 

CT-VOICE.DRV [MemVoice] SBSIMhandles=nn 

Default is 10. This parameter specifies the number of SBSIM handles 
to reserve. You can load several VOC files into extended memory and 
play them individually. The number of voice pieces you can place in 
extended memory is specified by this option. Each handle takes two 
bytes of conventional memory space. It is not advisable to allocate too 
many handles. 	If you specify SBSIMhandles as 0 (zero) in the 
configuration file, SBSIM allocates one. 

AUXDRV.DRV [Auxiliary] CDswitchSpeaker=aa 

Where aa equals ON or OFF Default is OFF This option indicates 
whether to swap left-right speaker for Compact Disc output control by 
the Mixer. This switch allows the auxiliary driver to swap the control of 
the left and right outputs from the CD. 

SBMIDI.EXE [Midi] BufferSize=nn 

Buffer size default is 32 K. If the buffer size is set to zero, SBSIM does 
not allocate a buffer for MIDI files. The application must set aside its 
own buffer before starting MIDI music. 	This prevents several 
applications from using the same piece of music. 

SBMIDI.EXE [Midi] MidiMap=nn 

Default is 0. This parameter, which spcifies the type of MIDI files to 
be played, are as follows: 

0=General MIDI files 
1 =Basic MIDI files (for Multimedia Windows) 
2=Extended MIDI files (for Multimedia Windows) 
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How SBSIM Uses 
Extended Memory 

SBSIM makes use of extended memory through its own set of handles, 

numbered from one onwards. These are SBSIM handles, not extended 

memory handles (although there is a one-to-one correspondence). You 

can specify the number of SBSIM handles in the configuration file using 

the SBSIMhandles=nn option. 

Generally, to use SBSIM's extended memory method, an application 
loads a file into one of the SBSIM handles and subsequently tells SBSIM 

to play the voice file from the SBSIM handle. When the VO\C file is not 

needed, the associated SBSIM handle is released along with the actual 

extended memory allocated for the file. SBSIM commands provide the 

ability to use this method. 

The extended memory handler supported is HIMEM.SYS. If another 

extended memory manager is used, it must conform to Microsoft's 

Extended Memory Specifications Version 2.00 and above. 

Using SBSIM 
	

To load SBSIM: 

1. Change to the \SBPRO\SBSIM subdirectory. 

2. Type SBSIM and press Enter. 

3. To load SBSIM with a different or customized configuration file, 

type SBSIM followed by the name of the configuration file. For 

example, SBSIM MUSIC.CFG. 

Note: SB SIM loads with the default configuration file SBSIM.CFG. You 

must enter path information for configuration files not in the same 

directory as SBSIM. SBSIM C:\CONFIG\SBSIM\MUSIC.CFG is an 

example. 

To remove or unload SBSIM from memory: 

1. From the \SBPRO\SBSIM subdirectory type SBSIM IU 

Other command options include: 

■ /Q—Suppresses messages displayed to screen while loading 

■ /H—Displays a help screen of available options 
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Using SBSIM with 
other Programs 

To get you started using SBSIM and to provide a better understanding of 
what the Sound Blaster Standard Programming Tool is all about, we have 

included three programs: Voice, Music and SoundFX. These programs 

let you play voice (.VOC) and music (.CMF) files from the DOS line in 

background mode and control fading and panning effects. 

Note: You can use the default configuration file, SBSIM.CFG, create 

your own or customize the default configuration file. If your configura-

tion file has a name other than SBSIM.CFG you must enter it after 
SBSIM. Refer to the section on using SBSIM. 

Using the Voice 	To use Voice: 

Program 	 1. Change to the \SBPRO\SBSIM subdirectory. 

2. Type SBSIM and press Enter. 

3. Type VOICE along with any of the following options. 

Voice Options You can specify one or more of the following options or switches. The 

program processes these options from left to right. Some of the options 

require additional parameters. 

Option Description 

/START:filename This option plays the voice file specified by 
filename. The path must be specified if the voice 
file is not in the same directory. Default .VOC file 
extension is used if one is not specified. 

/STARTX: 
SBSIMhandle 

Plays voice data from extended memory that 
was loaded into the requested SBSIM handle. 
CT-VOICE must be loaded with extended 
memory support indicated. 

/WAIT:marker Lets program wait until a marker value is en-
countered in the voice file, or until the voice 
output ends. Such markers can be inserted into 
the VOC file using the Voice Editor or Voice 
Utilities. 

Continued On Next Page 
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Voice Program 
Command Line 
Examples 

Option Description 
/STOP Stops playing of voice file. 

/PAUSE Pauses playing voice file. The /CONTINUE 
options resumes playback. 

/CONTINUE Resumes paused voice file. 

/SPEAKER:on I off Turns speakers ON or OFF. 

/LOADXMS:SBSIM 
handle,filename 

This switch loads the voice file into the SBSIM 
handle given by parameter SBSIMhandle. This 
can range from one to a maximum number 
handles specified in the configuration file (de-
fault is 10). The path of the voice file can be 
specified in the filename ino it is in the same 
directory. Default voice file extension is .VOC. 

A voice file can be loaded into any free SBSIM 
handle. 	If a particular SBSIM handle already 
holds voice data not being played, this old data 
is erased and the new file is oaded. 

If the SBSIM handle is playing from VOICE, 
LOADXMS will fail. LOADXMS also fails if there 
is insufficient extended memory. 

/FREEXMS:SBSIM 
handle 

Frees a SBSIM handle while holding voice data. 
Use this option when a particular voice data is 
not required any longer. If a SBSIM handle is 
playing from VOICE, FREEXMS will fail. 

Note: When using the extended memory commands /OUTX, 

/LOADXMS, and /FREEXMS, have SBSIM load CT-VOICE with 

extended memory usage indicated. 

VOICE /SPEAKER:ON /START:TEST.VOC 
This command turns on the speaker and plays the demo file TEST.VOC. 

VOICE /STOP 
Stops current voice from playing. 

VOICE /START:TEST.VOC /WAIT:0 
Plays the voice file TEST.VOC and return when the voice is completed. 
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Using the Music 
Program 

VOICE /CONTINUE 
Continues playing voice file. 

VOICE /LOADXMS:1,TEST.VOC 
Loads the voice file TEST.VOC into the SBSIM handle 1. Sufficient 

extended memory is required to hold the voice file. 

VOICE /STARTX:1 
Plays the voice data held in the SBSIM handle 1. A valid voice file must 
be loaded into the handle before this command is called. Refer to previous 

example. 

VOICE /STOP /FREEXMS:1 
Stops any active voice file and then frees SB SIM handle. Releases handle 

only when the voice data in no longer required. 

The Music program lets you control CMF or MIDI music from the DOS 

command line. 

Note: You should use either CMF or MIDI music files, and not both. 

To run Music: 

1. Change to the \SBPRO subdirectory. 

2. Type SBFMDRV or SBMIDI and press Enter. 

3. Change to the \SBPRO\SBSIM subdirectory. 

4. Type SBSIM including any options and press Enter. (Refer to 

the SBSIM section on optional parameters.) 

5. Type MUSIC along with any options (see Music Options) and 

press Enter. 

Note: You can use the default configuration file or create your own. 

The file must have a line to handle FM or MIDI music. 
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Music Options 

Music Program 
Examples 

Option Description 

/START:filename This option plays the music file specified by 
filename. The path must be specified if the voice 
file is not in the same directory. Supports CMF 
and MIDI files. 

IWAIT:mm Lets program wait until mm marker value is 
encountered in the voice file, or until the music 
output ends. Supports CMF file. 

/STOP Stops playing of voice file.Supports CMF and 
MIDI files. 

/PAUSE Pauses playing voice file. The /CONTINUE 
options resumes playback. Supports CMF and 
MIDI files. 

/CONTINUE Resumes paused voice file. Supports CMF and 
MIDI files. 

/TEMPO: pp Changes music speed. Tempo pp is entered as 
a percentage of the actual music speed. For 
example, to reduce the music speed to half of 
actual speed, type MUSIC /TEMPO:50. 
Changing the speed can defeat the musical 
effect. The Music program keeps the speed 
within a reasonable range to prevent it from 
going too fast or too slow. Supports CMF files. 

/TRANSPOSE:ss Transposes the music to a higher or lower key 
(pitch). The value ss entered can be either 
positive or negative. The entry range is from 12 
to -12. The default is 0. Supports CMF files. 

/REPEAT:rr rr is the number of times the music file plays. 
Setting repeat count to -1 causes the music to 
play continuously. Supports CMF files. 

/MIDIFMT:ff ff is one of GEN, BAS or EXT, and specifies 
which MIDI file type to play. Supports MIDI files. 

MUSIC /START:RANGE.CMF 
Plays the file RANGE.CMF 

MUSIC /STOP 
Stops playing current music file. 
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Using the 
SoundFX 
Program 

MUSIC /START:RANGE.CMF /WAIT:80 
Plays the file RANGE.CMF and return when the music file finishes 

playing or the marker 80 is encountered. 

MUSIC /START:RANGE.CMF /TEMPO:80 /TRANSPOSE:2 
Plays the RANGE.CMF, changes its speed to 80 percent of actual speed 

and raised the pitch by two semitones. 

MUSIC /START:RANGE.CMF /WAIT:81 /PAUSE 
Plays the file RANGE.CMF and waits for the marker 81. When the 

marker is encountered, it pauses the music. If the marker is not encoun-

tered, the program waits until the music file finishes playing. 

MUSIC /CONTINUE 
Resumes playing paused file RANGE.CMF. 

MUSIC /START:STOMP.MID /MIDIFMT:GEN 
Plays the MIDI file STOMP.MID using the GEN Midi format. 

This program uses SBSIM to lets you control panning and fading sound 

effects. 

■ Fading — The process of gradually increasing (or decreasing) 

the sound volume until a certain level is reached. 

■ Panning — The process of having the sound move from right to 

left (or vice versa). 

SoundFX can have fading and panning occur in the background so you 

can continue your current tasks without stopping these effects. 

You can set fading and panning effects such as: 

■ Duration — Length of fade or pan. 

■ Volume Level— Right and Left channel volumes. 

■ Repeat count — Number of times fading or panning repeats. 

■ Yo-yo Effect— Fading to one sound level and then back to the 

original volume level creates the yo-yo effect. For panning, the 

yo-yo effect is created by panning from left to right and back to 

the left again (or vice versa). 
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You can set fading, panning and volume level for all sources: 

■ Master 

■ Voice 

■ Music 

■ CD 

■ Line 

■ Mic (Can set volume only. Does not work with fade or pan 

commands.) 
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SoundFX Commands 
Command Description _ 

GET Lets you view the selected sources status: 
volume level, the panning and fading status 
Note: Source refers to the following: MASTER, 
VOICE, MUSIC, CD, LINE and/or MIC. You can 
request status for all sources and effects in the 
same command line. 

Example: SOUNDFX GET VOICE FADE. 

SETVOL This command lets you set both left and right 
volume levels for selected sources. 	Values 
range from 0 (no sound) to 255 (loudest). If you 
omit the right volume level, both the right and 
left volumes are set to the specified left volume 
level. 	You cannot use this command if the 
source is currently being panned or faded. 
Note: Do not specify a right volume for MIC. 

Example: SOUNDFX SETVOL LINE 255,80 

FADE This sets up the fading effect for the selected 
source. You can only select one source at a 
time with this command. The following options 
are available with this command: 

BEGINVOL — Set beginning volume level for 
right and left channels. Values range from 0 (no 
sound) to 255 (loudest sound). 

ENDVOL — Sets ending volume level for right 
and left channels. Values range from 0 to 255. 

REPEAT — Specifies Fade repeat count. If -1 
is specified, fading continues non-stop or until a 
STOP command is encountered. Default is 1. 

DURATION — Specifies time value for length 
of fade in milliseconds. Default is 500 millisec-
onds. 

YOYO — Selects yo-yo feature either ON or 
OFF. Default is ON. 

Example: 	SOUNDFX 	FADE 	MUSIC 
BEGINVOL 150,200 ENDVOL 35,35 REPEAT 
2 DURATION 2000 YOYO OFF 

Continued on Next Page 
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Command Descriptions 

PAN Sets up the panning effect for the select source. 
You can only select one source at a time with 
this command. The following options are 
available with this command: 

BEGINPOS — Specifies the starting position of 
the panning. Values range from 0 (left most) to 
255 (right most). Default is 0. 

ENDPOS — Specifies the ending position. 
Values range from 0 to 255. Default is 255. 

REPEAT— Specifies repeat count for panning 
effect. If -1 is specified panning continues until 
a STOP command is encountered. Default is 1. 

DURATION — Specifies time value for length 
of fade in milliseconds. Default is 500 millisec-
onds. 

YOYO — Selects yo-yo feature either ON or 
OFF. Default is ON. 

Example: SOUNDFX PAN MUSIC BEGINPOS 
35 ENDPOS 230 YOYO OFF REPEAT 2 DU-
RATION 3000 

START Starts the panning and fading for all selected 
sources. Once fading and panning has started, 
you cannot set up the sources for more fading 
and panning without ending the current process 
first with the STOP command. 

Example: SOUNDFX START 

STOP Stops the fading or panning for the specified 
source. If a source is not specified, this command 
stops all sources. 

Example: SOUNDFX STOP MUSIC 

PAUSE Pauses the fading or panning process. 

Example: SOUNDFX PAUSE 

CONTINUE Continues the fading or panning process 

Example: SOUNDFX CONTINUE 
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Note: You do not need to specify all options. Options not specified use 

the default value. 

To use SoundFX: 

1. Before using SoundFX, you need to run SBSIM. Also, your 

configuration file needs to load the Auxiliary driver 
(AUXDRV.DRV). 

2. Start music and voice output using the Voice and Music programs. 

3. Use the SOUNDFX SETVOL command to set the initial sound 

volumes for sources to be faded. 

4. Use the SOUNDFX FADE command set up the sources to be 

faded. 

5. Use the SOUNDFX PAN command to set up the sources to be 

panned. 

6. Use the command SOUNDFX START to begin fading and 

panning for all the sources that have been set up. 

More SoundFX 
Examples 

SOUNDFX GET MASTER 

Gets the current status for the Master volume. The output may be 

something like : MASTER - L:128 R:128 PAN:OFF FADE:OFF. 
This is interpreted as follows: 

Left volume = 128 

Right volume = 128 
Panning not in effect 

Fading not in effect 

Note: If panning is in effect, the pan position appears in parenthesis after 

the PAN status. 

SOUNDFX GET MASTER PAN 
Gets the current panning status of the Master source. You might see 

something like: MASTER - PAN:OFF 

SOUNDFX GET MASTER LINE 
Gets the current full status for the Master and Line-in sources. 
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SOUNDFX SETVOL VOICE 230,80 
Sets the volume of the Voice source to 230 left, and 80 right. 

SOUNDFX FADE VOICE ENDVOL 0,0 
Sets up yo-yo fading for the Voice source, does not repeat, duration is one 

half second (500 milliseconds), and ending at left volume 0, and right 

volume 0. 

SOUNDFX PAN MUSIC BEGINPOS 40 ENDPOS 200 REPEAT 10 
DURATION 10000 
Sets up yo-yo panning for the Music source, repeats 10 times, duration is 

ten seconds (10000 milliseconds), starting at position 40 (near the left 

side), and ending at position 200 (near the right side). 

SOUNDFX START 
Start the fading and panning action. Assuming the previous two com-

mands have been carried out, this START command starts fading for the 

Voice source, and panning for the Music source. 

SOUNDFX STOP MUSIC 
Stop the Music source panning action. 
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Chapter 10 Playing Music Files 

Playing music files is easy with the Multimedia Audio Card. We have 

included two programs, PlayMIDI and PlayCMF, so you can play these 

music files formats from DOS. 

Playing MIDI Files This program located in the \SBPRO\PLAYMIDI subdirectory. Before 

you can use the PlayMIDI program the driver must be loaded. The driver 

SBMIDI is located in the SBPRO directory. 

➢ Entry Format: 

PLAYMIDI <MIDIFILE> [IFMT:type] [/DRUM: channel] 

To play a MIDI file: 

1. Change to the SBPRO directory. 

2. Type SBMIDI and press Enter to load the driver. 

3. Change to the \SBPRO\PLAYMIDI subdirectory and type 

PLAYMIDI <1VHDIFILE> and press Enter. 

Note: The SBMIDI drivers reads the environment setup of the Multimedia 

Audio Card's I/O port. If you have changed your hardware configuration, 

run SET-ENV. 
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The following options are available with PlayMIDI: 

■ IFMT :type— This sets the program to play either Basic or 

Extended MIDI formats. Default is General MIDI format in 

which all 16 channels are used for MIDI event. 

■ IDRUM:channel—Defines the drum channel. Default is channel 
10. 

Example: PLAYMIDI STOMP /FMT:EXTENDED. 

PLAYMIDI JAZZ /FMT:BASIC 

Playing .CMF 
Files 

For those of you who wish to play .CMF music, we have included the 
PLAYCMF program and some .CMF files in the \SBPRO\PLAYCMF 
subdirectory. 

To play CMF files: 

1. Change to the SBPRO direcory and type SBFMDRV. This loads 
the driver in memory. 

2. Change to the \SBPRO\PLAYCMF subdirectory and type 
PLAYCMF filename and press Enter. 

Example To play the song AULD.CMF, type PLAYCMF AULD and press 
Enter. You can add the following options /Q and /S. 

■ /Q—Sets quiet screen mode. 

■ /S—Executes DOS command specified. You use this to play 

music in the bacground and to execute other DOS programs. 

To unload SBFMDRV: 

1. From the DOS prompt, type SBFMDRV /U and press Enter. 
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Appendix A Quick Help For 
Application Problems 

This appendix provides you with the causes of and remedies for some 
common problems you might face. 

From time to time, we will add new information into the README file 
that comes with the installation or setup disk. Some of these information 
may help solve the problems that are not listed here. Please read the 
README file. 

Under DOS The following are the possible problems under the DOS environment: 

Problem: SOUND environment not found 
BLASTER environment not found 

Cause: 	SOUND and BLASTER environment strings are not set 
Remedy: Enter DOS's SET command at DOS prompt to list the 

current environment setting. (Refer to your DOS manual 
for more details on the SET command.) 

If you could see the SOUND and BLASTER in the 
environment list, please seek technical assistance from the 
respective software house. 

If you could not see these two environment strings, please 
check your AUTOEXEC.BAT file to see whether the two 
statements, SET SOUND and SET BLASTER, are in the 
file. 

If the AUTOEXEC.BAT file does not contain these two 
statements, please refer to "General Information" in this 
manual on how to add them. You may also use SET-
ENV.EXE described in "General Information" to add the 
two statements. 
If the AUTOEXEC.BAT file contains SET SOUND or SET 
BLASTER environment, please reboot your system once. 
When the system restarts, enter SET command to list the 
environment setting again. You should be able to see these 
two environment settings. 
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If you still could not see these two settings, make sure that 
the statements for SET SOUND and SET BLASTER in 
AUTOEXEC.BAT are executed. A common problem is 
that these two statements come after some of your DOS 
shell or menu software. These software prevent SET 
SOUND and SET BLASTER from being executed. An 
easy solution is to move the SET SOUND and SET 
BLASTER to the first two lines of your AUTOEXEC.BAT. 

Problem: Error message—Out of environment space 
Cause: 	The system environment space is used up. 
Remedy: Add following statement in the CONFIG.SYS file: 

Device=C:\COMMAND.COM /E:512 /P 

Refer to your DOS manual for more information on the 
above statement. /E defines the size of the system 
environment. You may choose a higher value if the 
environment size is 512 (normally the next value is 1024). 

Problem: "No interrupt vector available" error when running 
SBFMDRV, SBMIDI or SBSIM. 

Cause: 	All the DOS software interrupt vectors (INT 80H and 
OBFH) are taken by a resident program that is misbehaving. 

Remedy: SBFMDRV, SBMIDI and SBSIM require an interrupt 
vector from INT80 to INT OBFH. These vectors are 
usually free in most of the system. 

However, these interrupt vectors will be fully occupied 
when SBFMDRV, SBMIDI or SBSIM wants to locate 
one for its use. 

You can avoid having problem with this kind of resident 
programs in the following ways: 

1. Boot the system again from a DOS diskette and then 
install SBFMDRV or SBMIDI from the \SBPRO 
sub-directory to confirm that the problem is solved. 

2. Execute these two drivers before running the 
misbehaving program. Insert the command to run 
these drivers before the misbehaving program in your 
AUTOEXEC.BAT. 
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Problem: Joystick port is not working 
Cause: 	Multimedia Audio Card's joystick port conflicts with the 

existing joystick port in the system. 
Remedy: Remove the Joystick Enable jumper. Use the joystick port 

in your system. 

Note : Removing Joystick Enable jumper will not remove 
the MIDI function of the card. The MIDI pins are still active 
on Multimedia Audio Card's joystick port. 

Problem: Joystick is not working properly in some programs 
Remedy: This is a classic problem with PC's joystick port that uses 

the CPU timing to calculate joystick position. When a CPU 
is too fast and the program does not take good care of the 
change in CPU speed, the wrong calculation would cause 
the joystick port to move to its unusable range. 

Multimedia Audio Card adheres to this PC standard and 
hence would inherit the same problem. You could confirm 
that the joystick port is working if some programs can 
handle the joystick properly. 

The possible remedy here is to switch the computer to its 
lowest possible speed. 

Problem: Software supporting Roland MPU 401 does not work 
Cause: 	Roland MPU 401 and Multimedia Audio Card MIDI port 

are not compatible 
Remedy: Multimedia Audio Card's MIDI port complies with the 

International MIDI Association recommended standard. 
The MPU 401 has some intelligence in its MIDI 
implementation. This intelligence could be easily emulated 
by a small driver routine in the PC. Hence, programs that 
run on the MPU 401 cannot work directly on the Multimedia 
Audio Card. 

Check for the latest version of your MIDI software or new 
software that support SB Audio Card or Multimedia Audio 
Card. There are many software supporting Multimedia Audio 
Card's MIDI port now. 

Problem: System hangs during voice output 
Cause: 	There is some hardware conflicts between Multimedia Audio 

Card and other adaptor cards. 
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Remedy: Remove all the non-essential adaptor cards first. If the 
interrupt on Multimedia Audio Card is on 7, change it to 
interrupt 5. This is because the interrupt 7 is sometimes used 
by the printer adaptor. 

Run the software again to test whether the problem still 
exists. If not, replace the other adaptor cards one at a time 
and run the software again to confirm that the system does 
not hang again. If the system still hangs, the last card 
replaced is in conflict with Multimedia Audio Card. Refer 
to the manual of the card for any possible hardware 
conflicts in I/O addresses, interrupt and DMA. To avoid the 
conflict, change the hardware setting of one of the cards. 

Problem: No sound output 
Cause: 	Volume is not turned on 
Remedy: Make sure that the volume of the card is set at mid-range. 

(Some of the cards do not have volume control). 

Use SBP-SET or SBP-MIX described in the "Voice Utilities" 
to adjust the volume to a higher level. 

Check your program for any option in turning on or off the 
sound output. If it has that option, make sure it is turn on. 

Under DOS The following are the possible problems under the Windows 
environment: 

Problem: There is no sound output when it starts up. 
Cause: 

	

	Drivers are not installed properly or the sound feature is not 
enabled 

Remedy: Make sure that the sound driver is properly installed. TO 
confirm that, follow these steps: 

® Select Control Panel in Main window group 
■ Select Drivers Applet 
■ Check the list of drivers installed. You should see a list 

of drivers for your Sound Blaster Pro card. 

Make sure that under the SYSTEM.INI in the Windows 
directory, the following are included: 

A - 4 Appendix 



[sndblst.drv] 
port=220 
int=7 
dmachannel=1 

The hardware setting must match the setting on your cards. 

Refer to Windows 3.1 manual on how to define the various 
sound for Windows start up and other events. 

Problem: The start up sound output does not stop. 
Cause: 	Wrong interrupt line used. 
Remedy: Correct the interrupt line specified in [sndblst.drv] section 

of SYSTEM.INI. 

Problem: The MIDI output could not be heard. 
Cause: 	MIDI mapper may not be correctly mapped. 
Remedy: Under Control Panel, there is a MIDI Mapper that maps the 

MIDI output to different MIDI devices. These two MIDI 
devices on Multimedia Audio Card are the external MIDI 
port and the internal MIDI synthesizer. 

If the mapper is mapped to MIDI port, you need to connect 
an external MIDI equipment. Normally, you should map it 
to the internal MIDI synthesizer. 

To change the MIDI Mapper, you need to understand 
MIDI. Consult some reference books for more details or 
consult someone who is familiar with MIDI. 

Problem: Warning message indicating MIDI file may not be played 
correctly 

Cause: 	The MIDI file may not be created using the authoring 
guideline defined. 

Remedy: To support hardware MIDI devices with different 
capabilities, there is an authoring guideline for musicians 
creating a MIDI file. They must create MIDI information 
for different hardware devices and include some special 
information in the MIDI file to mark that it is following the 
guideline. 

Warning message is displayed if the special information is 
not found in the MIDI file being played. 
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You get this message for MIDI files that are not specially 
created for Microsoft Windows with Multimedia Extension 
and Microsoft Windows 3.1. 

You may get this message for some of the MIDI files that 
are created for Microsoft Windows. The reason is that the 
special information is checked under Windows 3.1 and 
these MIDI files created earlier do not contain the special 
information. 
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